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An electronic version of this book is available free online at: 
www.freedomsoftware.info

Get it, read it, share it.
I hope you enjoy it.
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Preface
To understand why I love the power of affordable 
technology, you need to know that in 2000 three major 
events occurred in my life. First, the deregulation of the 
UK telecommunications market meant that I could 
make cheap calls on my cell phone. For just three pence 
(around five cents) per minute I could call anywhere in 
the UK or USA. That was less than one fifth of the 
previous price.

Second, the deregulation of telecommunications also 
meant that I had unlimited internet access for just £15 
(around $25) per month. Previously, dialup access in 
the UK was billed by the minute.

Third, I graduated as a medical doctor.

Only because of these events was I able to join three 
colleagues and co-found Medical Futures, Ltd. The 
previous years of study had not been kind to my bank 
account, and my first day job was a low paying 
research position.

But thanks to deregulation, I could afford to spend my 
evenings and weekends designing our company's site, 
co-ordinating with my colleagues in London, and 
interviewing innovators in the UK and USA. The core 
business of Medical Futures was spreading the lessons 
of those innovators.

Later that year I began my House Officer job (first year 
residency) and I became excited about what affordable 
technology can do when combined with a little 
education. My training that year was split between 
surgery, internal medicine, and family medicine, so I 
was able to see the computer needs of my colleagues in 
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all clinical specialities.

High quality handheld computers had become available for 
£125 (around $200). Working with Dr Laura Dean, I 
convinced clinicians in several departments that they could 
improve their information management using the machines. 
We then taught them how to use the machines with the least 
effort for the maximum benefit.

These successes led me to write a book called “Handheld 
Computers for Doctors”. I wanted to pass on enough 
knowledge and enthusiasm for the readers to be able to 
design their own local projects. To my continuing delight, I 
get emails every day from readers around the world who tell 
me of their projects.

In 2003 I came to the USA and met John Knight. I do not 
know why John was so kind with his time, but I am grateful 
that he was. He taught me about the next affordable 
technology, which is Free Software.

Of course, I instantly liked Free Software because the 
software was available free of charge. In this book I will 
show you how to use such software to save money.

What John also taught me was the reason for the 
capitalisation in Free Software. The software is Free as in 
Free Speech and Free Enterprise – it is about freedom itself. 
The importance of this point took me a little while to 
understand, and will take a little while to explain.

What I can tell you, though, is that freedom breaks 
monopolies, and that is a good thing. The reason that cell 
phone and internet prices were so good back in 2000 is that 
the UK government had spent the previous years breaking up 
British Telecom's monopoly on telecommunication services. 
Without this I could not have co-founded Medical Futures.

4
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Preface

Think what this could mean for you and your organisation. I 
have chosen the examples in this book to illustrate what 
hospitals, schools, charities, start-ups, governments and big 
businesses can do, but of course the lessons apply to every 
organisation. And if reading this book can save enough 
money to employ one more nurse or one more teacher, or to 
allow one more start-up to succeed financially, then my job 
is done.

Mohammad Al-Ubaydli, June 2005
www.freedomsoftware.info
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Introduction
I've finally done it – I've quit my job, and started 
my own company. I'll freelance from home and get 
rich quick.

Congratulations!

But starting up is so expensive. I need furniture, 
stationery, a fax machine, new PCs... and then 
there's the software. That's going to cost me more 
than the computers.

You should try Free Software.

I can get Microsoft Office for free? That's great.

Not quite. Microsoft makes some of its software 
available free of charge, like Internet Explorer and 
Outlook Express. But Microsoft Office costs money 
and you cannot get it for free.

Oh, that's no good to me.

But you can still get OpenOffice. It has most of the 
features of Microsoft Office, plus a few tricks of its 
own. And it's all for free from www.openoffice.org.

What's the catch? I must have to pay someone else 
later.

There is no catch. You can copy it too and use it on as 
many computers as you want without paying anyone 
any money.

If you want technical support, however, you can buy 
StarOffice. For $100 you get a CD copy of OpenOffice, 
a paper manual, and technical support from Sun 
Microsystems.

Oh I get it – the software is difficult to use, so that 
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you have to pay the money to understand how to use it.

Ah, so young yet so cynical.  But no – the software is quite 
simple to use. If you have used Microsoft Office in the past, 
you will find OpenOffice to be familiar for many tasks. This 
book will fill in the gaps.

Great. Any more money saving tips?

Sure. You can use Mozilla's Firefox for web browsing and 
Thunderbird for email instead of Microsoft's Internet 
Explorer and Outlook Express.

Why would I? I already get Explorer and Outlook 
Express for free.

They show you the difference between free software and 
Free Software.

Huh?

Outlook Express is software that is available free of charge. 
So it is free software. The problem is that it has many bugs 
and security holes. The virus MyDoom spread amongst 
millions of computers with Outlook Express, and even those 
with Microsoft Outlook, which is not free of charge. And 
MyDoom is just one of scores of dangerous viruses. 
Businesses around the world spent millions of hours fixing 
the infected computers.

And time is money...

Exactly. Thunderbird by contrast is Free Software – it has 
the four freedoms described by Richard Stallman1:

1. The freedom to run the program, for any purpose.

2. The freedom to study how the program works, and adapt 

1 Page 41 of “Free Software Free Society” by Richard M 
Stallman. GNU Press 2002. ISBN 1882114981.
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it to your needs.

3. The freedom to redistribute copies so you can help your 
neighbour.

4. The freedom to improve the program, and release your 
improvements to the public so that the whole community 
benefits.

The second and fourth freedoms are crucial. They allow 
anyone to see how Thunderbird works, identify security 
problems, and create fixes. Microsoft has some of the 
smartest software developers in the world, but they are still 
human, so they make mistakes.

The beauty of allowing everyone to see your mistakes is that 
you can use everyone's intelligence to find and fix them. The 
quality of Free Software comes from these two freedoms. 
Modern science is possible because of these two freedoms – 
scientists know them as the peer review process. And 
modern societies benefit because of these two freedoms in 
government – we know them as the democratic process.

Slow down comrade, all I want is cheap software.

Firefox shows you another advantage of Free Software over 
free software like Internet Explorer. It has many features that 
Internet Explorer does not, such as tabbed browsing, 
extensions, pop-up blocking and themes.

“Tabbed browsing”, “extensions”, “pop-up blocking”? I 
knew this would get too technical.

Don't worry, this book will explain all the terms for you. 
There are lots of wonderful things that computers can do if 
you have a background in computer science.

This book does not cover them.

Instead, I have focused on cost-effective uses of computers. I 
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Introduction

assume that you are not a computer professional – but if you 
have used email or the web in the past, then you know 
enough to make use of Free Software. This book will show 
you how.

9



Part I
OpenOffice.org

OpenOffice.org is the name of a comprehensive group 
of software tools. It should provide for most of your 
office needs.

For example, you can write letters and essays using 
OpenOffice.org Writer. I used it to write this book. For 
electronic and overhead presentations, use 
OpenOffice.org Impress. OpenOffice.org Calc allows 
you to create spreadsheets, with tables and calculations, 
then to create charts and graphs from the data in your 
tables.

If you have used Microsoft Office in the past, these 
tasks will be familiar to you. OpenOffice.org Writer is 
similar to Microsoft Word, as are Impress to 
PowerPoint and Calc to Excel. Like Word, Writer also 
allows you to create basic web pages.

OpenOffice.org also has a drawing tool. You can use 
this to create newsletters, business cards and posters.

Like the tools of Microsoft Office, those of 
OpenOffice.org work well together. For example, you 
can create a chart in Calc and include it in an article 
that you are writing in Writer. You can also include it 
in any of your Impress presentations.



Introduction

But OpenOffice.org can be better than Microsoft Office at 
working with other tools. For instance if a colleague sends 
you an article created in Microsoft Word, OpenOffice.org 
Writer allows you to open it, change it and save it in 
Microsoft Word format. You can send it back to your 
colleague, with the changes and they will not know that you 
had not used Microsoft Word.

However, you might like to let them know, because 
Microsoft Word 2003 costs $229 and Microsoft Office 
Standard Edition 2003 costs $399.99, while OpenOffice.org 
costs nothing.
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Switching from Microsoft 
Office to OpenOffice.org

“War and Peace”, “Gone With the Wind”, “An 
Appartment Called Freedom”2 – a great book needs 
great characters and this one is no exception. Six 
characters from different backgrounds will help 
illustrate the uses of Free Software in different settings. 
It is worth reading about all their examples to get ideas 
for your own situation. Finally, my lawyer wants you to 
know that although their computing needs and the Free 
Software solutions that they find are real, these 
characters and their stories are products of my 
imagination. So, without further ado, here they are:

Mrs Shrub Monsieur Braille Dr Digitalis

Mr Salah Al-Din Ms Yates Mr Big
• Mrs Shrub is the Mayor of London. Intelligent, 

ambitious and charismatic, she wants to cut the 

2 “An Appartment Called Freedom” by Ghazi A 
AlGosaibi. Kegan Paul International 1996. ISBN 0-7103-
0550-8.
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costs and increase the accessibility of government 
services.

• Monsieur Braille is a Frenchman working for an 
educational charity in Ghana. The charity operates a 
primary school.

• Dr Digitalis is a general practitioner (GP) who has spent 
the last two years on sabbatical in China researching and 
training in Chinese medicine. She knows that her 
combination of Western and Chinese medical skills will 
become highly sought after by British patients, so she sets 
up a private clinic in London's Harley Street.

• Mr Salah Al-Din is a history teacher at a private high-
school in Bahrain, an Arab country in the Gulf.

• Ms Yates is an entrepreneur. A few years ago she saw a 
businessman struggling to write on his handheld 
computer. She had an idea for a better writing stylus so 
she quit her job to focus on the design, production and 
sale of this product.

• Mr Big is the CEO of a Fortune 500 hotel company. The 
company has frozen all IT investments since 1999, when 
it had had to upgrade all its computers for Year 2000 
(Y2K) compliance. He knows another round of upgrades 
is due within the next 18 months.

13
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Examples
Mrs Shrub learns about the switch of governments to 
OpenOffice.org (page 14)

The GNU/Linux User Group helps M. Braille install 
OpenOffice.org (page 16)

Dr Digitalis uses OpenOffice.org to work with Microsoft 
Office files (page 17)

Mr Salah Al-Din uses the Arabic version of OpenOffice.org 
(page 18)

Ms Yates buys StarOffice to get templates and technical 
support (page 19)

Mr Big chooses OpenOffice.org for its cutting-edge features 
and buys StarOffice for his managers (p19)

Mrs Shrub learns about the switch of 
governments to OpenOffice.org

During her campaign, one of Mrs Shrub's 
interns showed her an article3 about Munich 
City Council. In May 2003, the council had 
voted to switch its 14,000 computers to Free 
Software.

Munich is not the only government making 
the switch. Singapore's Ministry of Defence has already 
installed OpenOffice.org on 5,000 computers, with 20,000 
computers planned for 2006. France's Paris City Council is 
switching over five years, starting with OpenOffice.org 
instead of Microsoft Office and ending with GNU/Linux 

3 “LiMux – The Linux Migration of the City of Munich” – 
www.suse.de/en/company/press/services/information/linux/lim
ux.html.
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Switching from Microsoft Office to OpenOffice.org

instead of Microsoft Windows. And Norway's Bergen City 
Council would move all 32,000 of its schools' computers to 
OpenOffice.org and GNU/Linux by 2005.

Meanwhile in 2004 the Chinese, Japanese and South Korean 
governments had signed an agreement to invest in 
developing GNU/Linux for the region.

She noted several lessons from the article. First, that moving 
to the latest versions of Free Software packages was cheaper 
than the latest versions of proprietary packages. This was 
despite the efforts of a special delegation from Microsoft that 
had promised Munich considerable cuts in licensing prices.

Second, the move to Free Software still had some costs, 
eventhough the software itself is free of charge. In fact 
Microsoft offered licensing costs of $23.7 million versus the 
projected immediate costs of $35.7 million for the switch. 
That is because IT staff had to install all the new software on 
all of the computers and configure the network settings to 
allow the computers to work with each other.

Finally, she learned from her intern that the move to Free 
Software need not be sudden. Bergen is switching all its 
software, including abandoning Windows, while Singapore 
focused just on OpenOffice.org. The switch from Windows 
to GNU/Linux is harder and requires staff training.

On the other hand the switch to OpenOffice.org is much 
easier, as the appearance is similar to Microsoft Office, the 
software works on Microsoft Windows and OpenOffice.org 
can open and save files in Microsoft Office format.

She decided that in the first year she would standardise 
London government's computers to OpenOffice.org. The 
head of her IT department downloaded a copy of the 
software (www.openoffice.org), copied it onto CDs and 
distributed these to the other members of staff who then 
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installed it onto all the computers. They also bought 100 
copies of “OOoSwitch”4, which they distributed around the 
London offices and provided training for the non-IT staff.

The GNU/Linux User Group helps M. 
Braille install OpenOffice.org

M. Braille heard about Free Software from 
the United Nations Development 
Programme's International Open Source 
Network (www.iosn.net). He downloaded a 
free copy of their book about Free 
Software5.

After months of efforts, M. Braille finally achieved his goal: 
he collected 60 computers as charitable donations from 
companies in the local area. These machines were out-of-
date as far as the businesses were concerned, many of them 
bought back in 1995. But for M. Braille's class they were 
perfect, as each machine included Windows 95, a drive for 
CDs and an ethernet card for connecting to the internet.

He would be able to provide one machine for each pair of his 
students in Ghana.

He explained his project to the local GNU/Linux User Group 
(LUG - www.linux.org/groups). The members were keen to 
help. They provided him with several CD copies of 
OpenOffice.org and two members spent a weekend installing 

4 “OOoSwitch: 501 Things You Wanted to Know About 
Switching to OpenOffice.org from Microsoft Office” by Tamar 
E Granor. Hentzenwerke Publishing 2003. ISBN 1-930919-36-
0.

5 “Free / Open Source Software Education Primer” – 
www.iosn.net/education/foss-education-primer.
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the software onto the 60 computers.

Dr Digitalis uses OpenOffice.org to 
work with Microsoft Office files

Dr Digitalis found OpenOffice.org on the 
CD of a computer magazine. By installing it 
on her own computer and that of her 
secretary she saved the £544 charge (around 
$1000) for two copies of Microsoft Office 
Standard edition.

However, she would be doing much of her work with 
doctors in the UK's National Health Service (NHS) and 
would have to read and follow the protocols and guidelines 
of the local NHS Hospital Trust. Her colleagues were 
accustomed to sending and receiving documents in 
Microsoft Word format and all of the guidelines and 
protocols were also in that format.

Opening Microsoft Office documents was easy. When she 
installed OpenOffice.org on her laptop with Microsoft 
Windows, OpenOffice.org became the default program for 
opening documents in Microsoft Word, Excel or PowerPoint 
format. Whenever she received such a document from her 
NHS colleagues, or from an NHS website, OpenOffice.org 
opened it and displayed it perfectly.

Dr Digitalis decided to stick to Microsoft Office format for 
saving all her documents. The Options... dialogue from the 
Tools menu included a section titled Microsoft Office. This 
allowed her to work with her colleagues' Microsoft Word, 
PowerPoint and Excel documents without needing to buy 
Microsoft Office.

17
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Mr Salah Al-Din uses the Arabic 
version of OpenOffice.org

Mr Salah Al-Din wanted to show his 
students how to use computer tools to 
research historical topics. He wanted to 
teach them how to write professional 
scholarly essays about history; and he 
wanted the school's students to provide 

educational material for other schools and for the students' 
parents. In short, he had a vision.

He began by downloading a copy of the Arabic version of 
OpenOffice.org. The software is available in scores of 
languages from around the world. The Arabic version 
includes an Arabic user-interface and the ability to cope with 
bidirectional writing. This is important because Arabic is 
written from right to left.

He installed a copy on every one of the machines in his 
classroom. Because he knew that other teachers would 
eventually become interested in the software, he installed the 
English version onto the computers in the English language 
classroom. That way, the students could learn English 
computer terms by comparing them with the identical 
commands in the Arabic software version. He also created a 
CD with both versions that he lent out to the students, 
because the students soon asked to install the software on 
their parents' computers at home.

18
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Ms Yates buys StarOffice to get 
templates and technical support

Ms Yates bought a copy of StarOffice for 
her laptop. In researching software tools to 
buy for her business, she had read about 
OpenOffice.org's capabilities and its 
wonderful price.

But she wanted to use StarOffice's 
commercial features. StarOffice is built from the same Free 
Software code as OpenOffice.org, but is sold by Sun 
Microsystems (www.sun.com/staroffice), with prices starting 
at $80 for online download. Included in the price are 
templates for all parts of the software, including the 
presentation tool. She wanted this in order to create her own 
custom professional presentation as soon as possible.

She also wanted to take advantage of the 90 days of 
technical support provided by Sun, because she was unsure 
about how well she would get on with the software at the 
start.

Mr Big chooses OpenOffice.org for its 
cutting-edge features and buys 
StarOffice for his managers

Mr Big's Chief Technology Officer (CTO) 
provided him with a plan for the transition to 
Free Software. The easiest win at the start 
would be from switching all the company's 
current computers to OpenOffice.org.

These machines only had Microsoft Office 
97 and so could benefit from the newer features of 

19
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OpenOffice.org such as the document review feature. This 
allows the author of a text document to email it to colleagues 
for review. They in turn can make changes to the document 
and OpenOffice.org keeps track of those changes. When 
they return the document, it highlights the changes and the 
author can approve or reject each of the changes.

Because OpenOffice.org was available free of charge, the 
company saved money relative to what it would have spent 
on upgrading to the latest version of Microsoft Office.

The IT department also saved time and effort in managing 
software licenses. Microsoft Office of course could only be 
installed on as many machines as the company had 
Microsoft Office software licenses. This helped offset the 
time that the IT department had to spend installing the 
software on all the old machines.

The company did invest in StarOffice for the managers, 
however. This was because they could save time by taking 
advantage of the templates in the software. Technical 
support was available through Sun, but Mr Big's company's 
IT department was capable of providing that support in-
house. The company bought 300 licenses, qualifying for a 
bulk discount, so paid $50 per copy.

Of course, OpenOffice.org and StarOffice shared the same 
document format, so managers and junior staff could share 
documents easily regardless of which software package they 
used. And both packages were also able to handle any of the 
company's old Microsoft Office documents and any new 
documents sent from other organisations that still used 
Microsoft Office.

Learning from the characters
This book is not a computer manual, but a showcase of what 
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you achieve with Free Software. I wrote it to be easy enough 
to read in bed and to inspire you to use Free Software the 
next day.

Therefore you will not find step by step instructions within 
these pages.

However, selecting OpenOffice.org Help from the Help 
menu will provide you with most of the instructions you will 
need (see Figure 1). The Index tab allows you to search for 
particular features that the characters used.

For example, to learn how Mr Big used the macro recording 
feature in the next chapter, type macro under the Search term 
in the Index tab. As soon as you finish typing 
OpenOffice.org will provide a list entitled macros that 
includes recording. Click twice on this to read the 
instructions.

Figure 1: OpenOffice.org's help documentation is detailed

Alternatively, clicking the  icon allows you to explore the 
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features of OpenOffice.org. The documentation is 
surprisingly clear and detailed.

Finally, if you prefer to read the instructions in a book rather 
than on a computer screen, I have recommended several in 
the examples that follow. Happy reading.

Further resources
● OpenOffice.org – www.openoffice.org

● StarOffice –  www.sun.com/staroffice

● Example OpenOffice.org CD site (USA) – 
www.getopenoffice.org

● Example OpenOffice.org CD site (UK) – 
www.8daysaweek.co.uk

● “OOoSwitch” by Tamar E Granor. Hentzenwerke 
Publishing 2003. ISBN 1-930919-36-0.

● GNU/Linux User Groups – www.linux.org/groups

● United Nations International Open Source Network – 
www.iosn.net

● IOSN book site – www.iosn.net/education/foss-
education-primer
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Text documents
“Freedom of the press is guaranteed only to those who 
own one.” — A. J. Liebling

Every ten years, as part of the US Census Bureau's 
counting of voters, the results from a questionnaire by 
the National Endowment for the Arts are also collated.

These results6 are regularly quoted in the press as 
showing that Americans are reading less than ever 
before. Of course they might be, because they have 
more TV, more radio, more films and now more 
computer games than ever before. All these media are 
competing for every citizen's limited time.

What often goes unmentioned, however, is the amount 
of writing that Americans do. In 2003, the USA broke 
another publishing record, producing over 175,000 
books. (The UK broke its own, with almost 120,000). 
And of course, there are more people writing websites 
than ever before.

Go on – join the revolution and write something.

6 “Reading At Risk: A Survey of Literary Reading in 
America” – www.nea.gov/pub/ReadingAtRisk.pdf. 
National Endowment for the Arts, Research Division 
Report #46.

http://www.nea.gov/pub/ReadingAtRisk.pdf
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Examples
Shrub's switching success (page 24)

Ms Yates's templates (page 25)

M. Braille teaches typing (page 26)

Mr Salah Al-Din spell checks and keeps track of reviewer 
corrections (page 28)

Dr Digitalis creates PDF documents (page 31)

Mr Big's staff use macros to automate common tasks (page 
33)

Shrub's switching success
For most of the staff at the Mayor of 
London's office, the switch to 
OpenOffice.org was painless. They could 
open all of their old Microsoft Office 
documents and were soon creating new 
OpenOffice.org files.

The few staff who had difficulties were actually the more 
experienced Microsoft Word users. They regularly used 
Word's more advanced features and OpenOffice.org Writer 
places these features in different parts of the program.

However, they found “OOoSwitch”7 to be a very useful 
book. As the title promised, the book showed them how to 
use all those advanced Microsoft Office features in 
OpenOffice.org. But its question and answer format (e.g. 
“How do I leave white space between paragraphs?”) meant 

7 “OOoSwitch: 501 Things You Wanted to Know About 
Switching to OpenOffice.org from Microsoft Office” by Tamar 
E Granor. Hentzenwerke Publishing 2003. ISBN 1-930919-36-
0.
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that finding that information was quick and easy.

In fact the staff found the bite-size format made it enjoyable 
to learn about other features that they had not been aware of 
in Microsoft Office (e.g. “How do I put multiple columns in 
a document?”) and they taught these to their colleagues.

Ms Yates's templates
The first text file that Ms Yates created was 
a letter requesting a manufacturing quote. 
She had identified four companies that could 
produce the high quality prototypes she 
needed. The letter contained a list of her 
requirements and requests for the costs, time 

frames and samples.

Because she had bought the StarOffice version of 
OpenOffice.org Writer, she could use its templates. These 
made writing the letter quick and easy. They are available 
from the File menu's Templates and Documents item.

Writer offers a choice of letter styles and she picked an 
understated professional one. Writer then asked for the 
address of the recipient and the address that Ms Yates 
wanted to quote. It placed both at the top of the letter. The 
recipient's address would appear through the envelope's 
window once the page was folded.

Ms Yates was also able to insert her company's logo at the 
top of the page by clicking on the  icon.

When listing her requirements, she clicked the  icon so 
that a bullet point appeared at the start of every line in her 
list. When she finished the list, she clicked the  icon again 
to write normal text without bullet points.

In listing the deadlines for different stages of production, she 
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clicked the  icon because the order of the deadlines in the 
list was important. This meant that the first deadline, on the 
first line, began with “1 -”, the second with “2 -” and so on. 
When she finished her list she clicked the  icon again to 
write normal text without numbers.

When the letter was complete she selected Print... from the 
File menu. She typed “2” in the Number of copies... box, 
then clicked the OK button. After a few seconds her printer 
produced two copies of her letter. She kept one copy in her 
filing cabinet and put the other into an envelope, with the 
address appearing through the envelope's window.

For the other three manufacturers she needed the same letter 
but with different addresses at the top. For each, she selected 
the address, pressed the delete key on her keyboard and 
typed in the correct address for that manufacturer. Then she 
printed one copy by clicking the  icon.

Writer's Mail Merge Wizard..., available from the Tools 
menu, is a powerful tool for automating a task like this. It 
would have allowed Ms Yates to create the letter, select the 
addresses to which she wanted copies of the letter sent and 
then have Writer take care of printing each letter with the 
correct address. Ms Yates would use the feature in the future 
for mailing adverts to her customers and press releases to her 
contacts.

However, in this case doing the four addresses manually was 
faster and soon Ms Yates was on her way to the post office.

M. Braille teaches typing
The children in M. Braille's class were 
delighted by the computers, especially when 
they figured out how to play the card games 
that come with Microsoft Windows.
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However, getting the children to use OpenOffice.org Writer 
was much harder as none of the children knew how to type. 
Writing an essay on the computer took far too long because 
they did not know their way around the keyboard. M. Braille 
was worried when he saw some of the children give up in 
frustration.

M. Braille downloaded and installed Tux Typing from 
http://tuxtype.sourceforge.net/downlo        ad  . It is made by 
Tux4Kids (www.tux4kids.com), an organisation that makes 
several other educational Free Software tools.

The children loved playing with Tux, the penguin hero of 
Tux Typing. Tux eats the fish coming down the screen, but 
only if the letters on the bodies of the fish were correctly 
typed (see Figure 2).

Figure 2: Tux Typing software teaches typing skills

Soon the children began to feed Tux the most fish. At first 
they typed with one finger on each hand, trying to type as 
fast as possible. Then they formed teams, with one student 
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covering the right of the keyboard and the other covering the 
left.

This showed the important role that teachers have to play in 
the classroom – computers support education, they do not 
provide it. M. Braille spent a few minutes with each child 
showing them how to use the left hand for the left side of the 
keyboard and likewise for the right. He also explained that 
the fingers should be along the middle row of the keyboard, 
with the left little finger on the “a” key and the index finger 
on the “f”. Similarly the right index finger would be on the 
“j” and the right little finger on the “;”.

At first, this way of typing slowed the children down. But M. 
Braille encouraged them to persist and soon they were able 
to beat their previous high scores: they had learnt to touch-
type. This skill would serve them well in adulthood as they 
entered the job market, but in the meantime it allowed them 
to write all their assignments on the classroom computers.

Mr Salah Al-Din spell checks and 
keeps track of reviewer corrections

As Mr Salah Al-Din explored the tools in 
OpenOffice.org Writer, he created exercises 
that would improve the students' learning.

First, he switched off the spelling checker in 
OpenOffice.org. From the Tools menu, he 
clicked Spellcheck and then clicked 

AutoSpellcheck8 until the tick mark ( ) disappeared. He 
knew that he could restart automatic spell checking by 

8 Of course, because the students were using the Arabic version 
of OpenOffice.org, they actually clicked the أدوات menu, then 
 The software included an Arabic .أوتوماتيكيا� and دقق الملء
spelling checker.
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clicking on AutoSpellcheck again, but for now he wanted to 
test the students' own spelling skills.

He would run dictation exercises with the class on the 
computer. At the end, he would show them how to run the 
spelling checker by clicking the Tools menu, then 
Spellcheck, then Check....

Of course, spelling checkers are not replacements for 
knowing how to spell correctly and Mr Salah Al-Din wanted 
to prove this point to the class.

Therefore he asked each student to give a copy of their file 
to another student and get that student to check the spelling 
manually. The students found several errors of meaning that 
automatic spelling checkers cannot find – for example 
“there” is spelt correctly if you mean the position (“I will 
look over there”) but incorrectly if you mean the possession 
(“I will look over their property”).

He then taught the students how to make the corrections on 
their friends' files efficiently. From the Edit menu, he told 
them to click on Changes then Record until the tick mark  (

) appeared. That meant that OpenOffice.org Writer would 
record every change made from that point onward. To stop 
recording at any time the student just had to click Record 
until the tick mark disappeared.

Figure 3: OpenOffice.org can track changes

OpenOffice.org makes these changes clear on the screen. For 
example, Figure 3 shows what happens when the sentence 
“This is the starting sentence” is changed to “This is the 
changed sentence”. The vertical line on the left-hand side is 
to show that a change has been made to that line of text. 
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Both “changed” and “starting” are in red, meaning that the 
change concerned those two words on that line. And the 
word “changed” is underlined because it has been added to 
the text, while “starting” has a strikethrough to show that it 
has been deleted.

Figure 4: accepting and rejecting changes to a document

The real fun began when the students returned each file to its 
original creator. The student could see which changes had 
been made, but also had the power to accept or reject each 
one. This feature is available by selecting the Edit menu, 
then Changes, then Accept or Reject... (see Figure 4). Mr 
Salah Al-Din used the same feature for his marking of the 
students' documents.

Mr Salah Al-Din was also able to add notes and comments to 
the document such as “7/10”, “very good”, or “have you 
thought about including information about Al-Khawarizmi9 
from the Wikipedia?”. This is possible through the Note... 

9 Abu Abdullah Muhammad bin Musa al-Khawarizmi was a 
Persian scientist, mathematician and author born around 780 
AD. He developed the concept of an algorithm in mathematics 
and is thus sometimes given the title “grandfather of computer 
science”. To learn more, see http://en.wikipedia.org/wiki/Al-
Khawarizmi 
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command from the Insert menu. A yellow rectangle would 
appear in the text, (see Figure 5) and moving the mouse on 
top of that rectangle would show the note to the student.

Figure 5: OpenOffice.org notes  
appear as yellow rectangles

Dr Digitalis creates PDF documents
OpenOffice.org provides an excellent tool 
for distributing completed files. This feature 
is not available in Microsoft Word. Dr 
Digitalis used it to send posters to the 
practices of other GPs announcing her 
launch party.

In the past she would have designed the poster in Microsoft 
Word and in fact she began this poster by opening one of her 
old Microsoft Word files in OpenOffice.org Writer. She then 
changed the layout and updated the details on the poster.

When the file was ready, however, she clicked Export as 
PDF... from the File menu. This feature is not present in 
Microsoft Word and to add it would require buying Adobe 
Acrobat, with prices starting from $299 on top of the cost of 
Microsoft Word itself. OpenOffice.org Writer creates PDF 
files free of charge.

PDF is an abbreviation of Portable Document Format, which 
hints as to its advantages. It makes your file (the 
“Document”) easily transferable (“Portable”) to any other 
computer. Adobe is the company that created the PDF 
standard. They originally did so to guarantee to graphic 
designers that files created on their own computers would 
look exactly the same on the computer of a printing 
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company.

This was important to Dr Digitalis. In the past, when she had 
given her Word documents to a printing company, she would 
have to spend some time at the printer's office double-
checking that the pages came out as she had wanted them. 
Often, in moving from her own computer to the printer's, the 
layout was slightly changed by a fraction of an inch. That 
fraction could mean that the final printout looked amateurish 
and careless. If she found such changes, she would have to 
spend more time at the printer's computer fixing them.

PDF made her confident that she did not need to spend that 
time. She just emailed the PDF file to her printing office, 
asked that 500 copies be printed and came by the next day to 
pick up the pages. These pages looked exactly as she had 
wanted.

PDF also made the process of emailing easier. A Microsoft 
Word or OpenOffice.org Writer file can quickly grow in size 
as more and more amendments are made. This is because the 
software keeps track of those changes to allow you to 
reverse them. However, when including the file in an email 
to the printer, such changes are not useful and the large file 
size becomes a problem. PDF documents are much smaller 
in size, making them great for email.

And so Dr Digitalis was also able to email the documents to 
her GP colleagues. In time, the posters that she had printed 
off would arrive in her colleagues' surgeries through the 
mail, but she knew that they would appreciate having the 
email reminder.

The GPs were able to open and view the file because almost 
every computer today comes with Adobe Reader10 

10 Adobe Reader is not Free Software, but it is free of charge. 
There are Free Software alternatives, but for now consider 
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(www.adobe.com/acrobat). This opens any PDF file and Dr 
Digitalis's poster appeared on her colleagues' computer 
screens exactly as she had intended it to.

Furthermore, the PDF file did not include anything that she 
did not want to appear. For example, if she had sent a 
Microsoft Word file her colleagues could have found out that 
her poster had originally been an advertisement for her old 
car.

Nor do PDF files allow changes to be made by the recipient 
of the file. This is crucial for clinicians. It would be terrible 
if Dr Digitalis had sent a Microsoft Word file that 
recommended drug dosages and one of the recipients 
accidentally deleted a decimal point from one of them. And 
it would be disastrous if that person then forwarded the 
amended document to others, because those recipients would 
have the wrong dosage and because they would think it had 
come from Dr Digitalis.

For all of these reasons, you should use PDF when sharing 
completed OpenOffice.org files. This feature, also accessible 
through the  icon, is available in all OpenOffice.org tools, 
including Writer, Impress and Calc.

Mr Big's staff use macros to automate 
common tasks

OpenOffice.org can be customised using 
OpenOffice.org Basic, a programming 
language. Like Microsoft Office's Visual 
Basic, it allows the fast creation of small 
programs to automate short sequences of 
tasks.

Adobe Reader good enough.
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For Mr Big's IT team members, the most important factor in 
making the switch to OpenOffice.org was their ability to 
customise it. The extraordinary flexibility of Microsoft's 
Office software has always been important for businesses 
and Mr Big's company was no exception.

For example, Mr Big's software developers wanted to create 
a macro that allowed a receptionist to print off a customer's 
bill. The macro would ask the receptionist for the name of 
the customer, then automatically get the amount of money 
that the customer owed, create a letter in OpenOffice.org 
Writer that included the customer's name and billing amount 
and print two copies of that letter.

OpenOffice.org makes this possible because it includes tools 
to connect to any database and because most of 
OpenOffice.org Writer's tasks (such as creating a letter) can 
be controlled with the OpenOffice.org Basic language.

This language is not the same as Microsoft Office Visual 
Basic, but it is similar. Mr Big's IT staff were able to quickly 
convert their old Microsoft Office macros into macros that 
did the same job in OpenOffice.org.

OpenOffice.org's help documentation covers this well. For 
tricky parts, they read the book “OpenOffice.org Macros 
Explained”11.

But it is not just programmers who can create macros. The 
Record Macro command from the Tool menu allowed Mr 
Big to create a macro simply by using OpenOffice.org 
Writer. The software kept track of the actions that Mr Big 
took until he clicked the  Stop Recording button. In this way 
he was able to create a macro that he called 
“PrintTwoCopies”. This would print two copies of his 

11 “OpenOffice.org Macros Explained” by Andrew Pitonyak. 
Hentzenwerke Publishing 2004. ISBN 1930919514.
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document every time he selected it from the Tools menu.

Further resources
● TuxType – http://tuxtype.sourceforge.net/

● Tux4Kids – www.tux4kids.com

● Wikipedia – www.wikipedia.org

● Adobe Acrobat and Adobe Reader – 
www.adobe.com/acrobat

● “OpenOffice.org Macros Explained” by Andrew 
Pitonyak. Hentzenwerke Publishing 2004. ISBN 
1930919514.
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Calculations and graphs
During the 1940s the US military was making full use 
of “computers”. These were nothing like the small 
machines that you and I are used to, nor even the room-
sized machines that IBM had originally sold to the US 
census back in 1890. Rather, “computers” were people, 
usually young men and women with undergraduate 
degrees in science and mathematics12.

Each “computer” would spend each day performing 
long and laborious computations, thankfully with the 
assistance of calculating machines. Each computation 
could answer questions about the outcome of a 
scenario.

OpenOffice.org Calc gives you more computational 
power than a whole roomful of these patient 
“computers”. It is an example of a spreadsheet, 
software that has transformed accounting and business 
planning. The rest of this chapter discusses peaceful 
uses of a spreadsheet.

At its most basic a spreadsheet like Calc allows you to 
create a table with column headings, rows of data and 
colourful formatting to enhance the presentation. If you 
want to create a beautiful table for your paper brochure, 
OpenOffice.org Calc may be your best starting point.

However, every number you enter into the table is a 
number the spreadsheet can use for calculations. Sums, 
averages, extrapolations, deviations, integrations and 

12 This story is taken from page 16 of the book 
“Supergenius” by B Bruce-Briggs. North American 
Policy Press 2000. The book is the biography of one such 
“computer”, Herman Kahn, who went on to found the 
Hudson Institute.
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differentials – computers compute and Calc is your personal 
computing slave.

And a spreadsheet brings life to its tables. If you change one 
number at the top of a table, the outcomes of all the 
calculations further down the table also change. For 
example, to find out what would happen to your profits if 
you decreased the unit price by 10% but increased sales by 
20%, change the unit price and sale price in the table. 
Almost as soon as you finish typing Calc will show you the 
outcome for profits. This makes Calc a powerful tool for 
planning.

Finally, Calc creates graphs from your tables’ data: pie 
charts, line graphs, histograms and scatter plots are just a 
few of the options that Calc gives you.
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Examples
M. Braille creates a simple and secure table of pupil 
attendance (page 38)

Mr Salah Al-Din sums and sorts (page 40)

Dr Digitalis creates graphs of her patient surveys (page 41)

Ms Yates copys and pastes chart from Calc into her Writer 
text documents (page 42)

Mr Big and conditional forecasting (page 43)

Mrs Shrub imports data and learns from the US Census 
(page 44)

M. Braille creates a simple and secure 
table of pupil attendance

M. Braille maintained a record of pupil 
attendance in a large book. The book served 
its purpose but he wondered if he could do 
better with OpenOffice.org Calc.

The program is well-suited to tables because 
its default display is of many rows and many 

columns. Down the left-most column he typed in the names 
of each of the pupils. Across the top row he typed in the first 
date of the new school year and then the second date.

He used Calc's automatic filling feature for the remaining 
days. First, he selected both dates. Calc displayed these in 
white text over a black background to indicate that they were 
selected and a thick black square appeared in the bottom 
right-hand corner to indicate that automatic filling was 
possible (see Figure 6).
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Figure 6: Begin autofill

He clicked on the square and dragged it to the right. When 
he let go of the mouse button, part of the row that he had 
dragged over was automatically filled with consecutive dates 
(see Figure 7). Automatic filling is a powerful feature and 
several sophisticated options are available in OpenOffice.org 
Calc through the Fill item of the Edit menu.

Figure 7: Calc can automatically fill a series

Calc provides many features for formatting the tables. M. 
Braille selected the top row and the left-hand column and 
changed their background colour to grey. For days on which 
a student was absent, he changed the background colour of 
that cell to red. It was easy to see at a glance the attendance 
of any class or student over the year.

M. Braille wanted to use one file for all his students in any 
one year. He made use of the sheets to divide each file by 
class. The sheets of a file are listed in the bottom left-hand 
corner of the screen (see Figure 8). He renamed each sheet 
by clicking on it with the right mouse button and selecting 
Rename sheet....

Figure 8: Sheets group relate tables and graphs

Finally, because he was keeping so much information in one 
file, M. Braille wanted to ensure its security. When saving 
the file he ticked the box Save with password and clicked 
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Save. Once he had filled out the password, Calc encrypted 
the file. This meant that, for all intents and purposes, the 
contents of the file could only be read by someone who 
entered the correct password to open the file.

Mr Salah Al-Din sums and sorts
Mr Salah Al-Din used OpenOffice.org 
to store his students' test marks. He 
created a table with the name of each 
student in the left-hand column and the 
date of each test in the top row. He 
wrote the test scores in the intersecting 
cells.

In the left-hand column, beneath the name of the last student, 
he typed in “Average”. The rest of the row would contain the 
average score of the students on each test. This analysis is 
easy because scores are numbers and Calc has many tools 
for running calculations on numbers.

After marking the first test of the year he filled an entire 
column with test scores. He clicked inside the blank cell just 
below this list of scores, which was on the same row as the 
“Average” heading.

Then he clicked the  icon to start the Function Wizard. He 
selected AVERAGE from the lengthy list of functions and 
clicked the Next button. He then indicated to Calc the cells 
that contained the data to be averaged by clicking on the first 
score and dragging down to the last one to highlight all the 
numbers in the column. He clicked the OK button and the 
average appeared instantly.

For subsequent tests he entered the scores in the columns to 
right, but he did not need to use the Function Wizard again. 
Instead he selected the first average, clicked on the thick 
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square that appeared in the bottom right hand corner and 
dragged to the right. The automatic filling of Calc took care 
of the rest, using the same AVERAGE function on the data 
to the right.

Finally, Calc is good for sorting text and numbers. Mr Salah 
Al-Din highlighted all the cells in his table and selected 
Sort... from the Data menu. First he sorted using the left-
hand column, ordering the tests by the names of the students; 
he printed that page off. Then he sorted again, this time 
using the column of the latest test's data. He printed that off 
to give the students their rankings.

Dr Digitalis creates graphs of her 
patient surveys

Every patient that consulted Dr Digitalis 
filled out a satisfaction survey that she had 
prepared. Her secretary entered the data 
from the paper survey into OpenOffice.org 
Calc.

Dr Digitalis could then analyse the data and 
create charts.

To create a graph, click in the top left corner of the data and 
drag down to the bottom right corner, ensuring that column 
and row headings are included in your selection. Click on the 

 icon, select the area of your chart, and Calc will show 
you the AutoFormat Chart dialogue.

The chart type of which Dr Digitalis was most fond was the 
pie chart – she used this at monthly team meetings to show 
the proportion of patients who found the care it received to 
be less than acceptable. When she had collected data over 
many months she used line charts to show trends over time. 
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Bar charts are good for comparing data from groups of 
patients, while XY charts show the relationship between two 
variables, such as waiting time and satisfaction.

Figure 9: The AutoFormat Chart dialogue

A chart created by Calc automatically uses the original table 
row and column headings for its labels. You can edit 
individual elements by double-clicking on them. For 
example, clicking twice on a slice of a pie chart allows you 
to change its colour. Likewise doing so on the x-axis of an 
XY chart changes its scale and the increments of its tick 
marks.

Ms Yates copies and pastes charts 
from Calc into her Writer text 
documents

Because OpenOffice.org is so well 
integrated you can use Calc charts in any 
other OpenOffice.org document. Click on a 
chart, select Copy from the Edit menu, 
switch to your other document and select 
Paste from its Edit menu.

In researching her business plan Ms Yates collected a lot of 
data about the market, her customers, and competitors. She 
stored these data in Calc and made several charts to support 
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her arguments.

She used this to incorporate charts into the Writer document 
of her business plan. The greyscale PDF that she printed for 
her bank manager illustrated her findings. She used the same 
charts in the Impress presentations to venture capitalists and 
the pie charts were projected in their colourful glory.

Mr Big and conditional forecasting
Calc supports scenario planning: changing 
the data in one cell changes the data in all 
the other cells and charts that depend on that 
cell. As Mr Big began his career as an 
accountant, he still loved a good spreadsheet 
document because of this feature.

For example, changing the revenue from one of his 
company's hotels changed the total for the region that 
contained the hotel and the total of all the regions.

The change impacted charts as well. For example, in the pie 
chart showing a region's contribution to revenues, that 
region's portion decreased and the other regions' portions 
increased in size. Mr Big and his team could immediately 
see the impact of changing costs and revenues on the 
affected charts.

Calc offers some powerful and subtle tools for the tabular 
data. For example, using Conditional Formatting... from the 
Format menu you can set a cell to appear red if its value is 
negative and black otherwise. Making this cell the sum of 
revenues and costs for the hotels in a region makes it 
immediately apparent when changing the revenues leads to 
losses for the region.

The Tools menu's Goal Seek... item allows the reverse – Mr 
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Big could set the target value for that cell and then calculate 
the revenues necessary from the hotels that contributed to the 
value of that cell.

Mrs Shrub imports data and learns 
from the US Census

Mrs Shrub liked the US Census website 
(www.census.gov). Like the best of US 
government websites it makes as much of its 
data publicly available as possible. She 
wanted to create a similar site for the 
statistics collected by London's government.

Like the UK's Census site13, the US site is impressively 
interactive with maps generated on the fly to illustrate data 
of any subset.

More significantly, its data were available for download and 
she could use these in OpenOffice.org. Of course Microsoft 
Excel files opened instantly in Calc and many of the 
business data were available in this format.

Other statistics were available in CSV format. This is 
simpler than Excel’s but it is an open standard that is fully 
supported by all spreadsheet software, including Excel and 
Calc.

Finally, other data were available in dBase format. 
OpenOffice.org includes Base, a database tool, that is 
capable of handling a whole range of database formats. 
Although Mrs Shrub had no interest in these files, she 
understood that businesses and citizens' organisations would 
benefit from having access to the data for their own analysis 
and integration.

13 www.statistics.gov.uk/census2001/  
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Further resources
● “Supergenius” by B Bruce-Briggs. North American 

Policy Press 2000.

● The US Census – www.census.gov 

● The UK Census – www.statistics.gov.uk/census2001/  
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Dr Whitfield Diffie is one of the few computer 
scientists to receive erotically-charged fan mail. His 
best known contribution to the world of computing is 
the co-invention of a method for protecting secrets 
electronically: public-key cryptography.

What is less well known is that he created the first 
presentation software. His program inspired his 
colleague Bob Gaskins to create PowerPoint14.

Microsoft eventually bought PowerPoint. On over 250 
million computers around the world businessmen, 
teachers, officials, clinicians, professionals and citizens 
are using PowerPoint to make their point.

Impress is the OpenOffice.org equivalent.

14 A fascinating history of PowerPoint appeared in The New 
Yorker's May 28th 2001 issue. Written by Ian Parker, 
“Absolute Power point” is well worth the read at:
www.physics.ohio-
state.edu/~wilkins/group/powerpt.html 

http://www.physics.ohio-state.edu/~wilkins/group/powerpt.html
http://www.physics.ohio-state.edu/~wilkins/group/powerpt.html
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Examples
M. Braille uses existing PowerPoint files (page 47)

Ms Yates creates a simple presentation and uses the 
StarOffice gallery (page 48)

Dr Digitalis creates a lecture handout (page 49)

Mrs Shrub creates animations and organisational charts 
(page 50)

Mr Big adds corporate logos and colours using the slide 
master (page 52)

Mr Salah Al-Din shares his presentations with other 
teachers (page 54)

M. Braille uses existing PowerPoint 
files

Around the world, many teachers use 
PowerPoint to support their lessons. And 
many of them make their PowerPoint files 
available for other teachers to use. In fact 
Microsoft's own site provides a whole range 
of materials 

(www.microsoft.com/Education/). 

OpenOffice.org Impress can open all these files. M. Braille 
found that for each particular lesson he could take elements 
from the lesson plans of several other teachers.

He could Copy entire slides that he liked and Paste them into 
his own Impress presentation. By choosing Slide Sorter from 
the View menu the order of the slides can be changed. The 
text can be changed by double-clicking on the slide 
containing it. Finally, the Layouts part of the Tasks pane on 
the right-hand side allows changing the layout of each slide 
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(see Figure 10).

Figure 10: The Layouts part of the Tasks pane

Ms Yates creates a simple presentation 
and uses the StarOffice gallery

Creating a new Impress document is easy. 
You can select OpenOffice.org Impress 
from the Start menu. Alternatively, within 
any OpenOffice.org file (including a text or 
spreadsheet document) you can select New 
from the File menu and then Presentation. 

To create a new slide, select Slide... from the Insert menu.

However, OpenOffice.org does not contain many templates, 
nor are the included graphics as slick as those in Microsoft 
PowerPoint.
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Figure 11: The StarOffice gallery

This is why Ms Yates was so pleased with having paid for 
StarOffice. It has many useful templates and a gallery of 
graphics. Within every application in OpenOffice.org the 
Gallery can be reached through the Tools menu, or by 
clicking on the  icon. The gallery of StarOffice has 
hundreds of useful graphics, including maps, icons and the 
infamous screenbean characters (see Figure 11).

Dr Digitalis creates a lecture handout
Dr Digitalis read “The Cognitive Style of 
PowerPoint”15. This 28-page essay is by the 
wonderful Professor Edward Tufte, who 
teaches courses in statistical evidence at 
Yale University. The essay is highly critical 
of “slideware” like PowerPoint and Impress:

Alas, slideware often reduces the analytical 
quality of presentations. In particular, the 
popular PowerPoint templates (ready-made 
designs) usually weaken verbal and spatial 
reasoning, and almost always corrupt statistical 
analysis. What is the problem with PowerPoint? 
And how can we improve our presentations?

15 “The Cognitive Style of PowerPoint” by Edward Tufte. 
Graphics Press 2003. ISBN 0961392150.
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One of the points that Tufte stresses is the importance of a 
good handout for sharing data with the audience. Showing 
the data on “slideware” limits the audience's ability to digest 
the data, while a detailed handout complements the overview 
that good slides can give.

OpenOffice.org has several features for creating handouts. 
First, there is the Handout Page, available from the View 
menu in Impress. This automatically includes reduced 
versions of each slide on a page with space left over for 
providing extra notes about the slides. The  icon at the 
bottom of the screen allows text to be added.

Second, because OpenOffice.org is so well integrated, you 
can Copy and Paste text, tables and charts from Writer and 
Calc. You can also do the reverse: create the handout in 
Writer, then Copy and Paste each slide from Impress into 
your text document.

Finally, the Handout Page in Impress automatically includes 
a header and footer area. In these Dr Digitalis put the title of 
her lecture, her name and the website address of her clinic. 
She knew that her detailed handouts would be so useful that 
they would be shared with other clinicians.

Mrs Shrub creates animations and 
organisational charts

Creating slideshows is not all that Impress is 
good for. The Drawing toolbar (see Figure
12) at the bottom of the window has many 
tools for creating shapes, colouring them in 
and connecting them.

For example, clicking the  icon allows 
the insertion of basic shapes like rectangles, ovals and rings. 
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The Line and Filling toolbar at the top of the page allows 
alteration of the border line and filling colour of a shape. 
And double-clicking on a shape allows you to write inside it.

Figure 12: The Drawing toolbar

These tools allowed Mrs Shrub to mock up quickly a neat 
diagram of anything that she wanted. She was able to show 
the website designer the elements she wanted displayed on 
the London government's website homepage, the layout of 
the staff newsletter, a birthday card for her sister and the 
organisation chart for her department.

The chart was particularly easy to create because of the 
Connector tool ( ) in the Drawing toolbar. This draws 
connecting lines between any two shapes. Impress correctly 
redraws each line every time one of the shapes it was 
connected to is moved.

Mrs Shrub brought her organisational diagrams to life using 
the animation feature of Impress.

Like Layouts, this is also available from the Tasks pane on 
the right hand side (see Figure 13). By clicking on Custom 
Animation you can Add... and Remove effects for each item 
of each slide.

For shapes representing employees lower in the hierarchy 
Mrs Shrub selected the Basic effect called Appear. The 
rectangle would appear during her slideshow when she 
pressed the spacebar.

For employees whom she wanted to single out for praise, she 
chose the Fly In effect and made the shape levitate from the 
bottom of the screen. She was always careful, however, to 
avoid too many animation effects, or effects that were too 
jarring. A classy lady, she did not need Tufte to tell her that 
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less is more when it comes to the special effects of 
slideware.

Figure 13: The Custom Animation part of the Tasks pane

Mr Big adds corporate logos and 
colours using the slide master

Impress has two features to ensure that 
different slides have the same background, 
logos and corporate theme. This was 
important for Mr Big and his executives as 
they give many lectures at industry 
conferences.

First, the Slide Master is available from the View menu. 
Changing any element in this view changes all of the 
elements in the Normal view (see Figure 14). For example, 
by changing the background to match the orange and amber 
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colours of the logo of Mr Big's hotel chain, the background 
in every single slide was changed. And pasting the logo in 
the top left corner of the master slide made it appear in the 
top left corner of every slide.

Figure 14: The Slide Master view

Furthermore, changing the size of the writing in the style of 
each Outline Level changes the size of that writing in every 
slide. Using this Mr Big changed the default typeface from 
Albany to Tahoma, his favourite.

The second important feature is saving the file as a template 
(see Figure 15) through the File menu's Save As... dialogue. 
The company made the template file available to all of its 
employees.

Whenever an OpenOffice.org template is opened, it creates a 
new file with the same default settings as the template. In 
other words, Mr Big's executives would begin their Impress 
presentations by opening the template. All their slides would 
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have the company's background, logo and typeface. Mr Big 
loved consistency.

Figure 15: The Impress Save As... dialogue

Mr Salah Al-Din shares his 
presentations with other teachers

Like M. Braille, Mr Salah Al-Din used 
Impress extensively in his lessons. However, 
he liked to make his files available to others 
through the school website. This was good 
for students who had missed his lessons 
through illness. He also shared the files with 

other teachers to save their time and to allow improvements 
to the lesson plans.

The Save As... dialogue of Impress (see Figure 15) offers 
several options, including Microsoft PowerPoint 
presentation and Microsoft PowerPoint template formats. 
For sharing on the web there are several useful read-only 
formats. Like OpenOffice.org Writer these are available 
through the Export... dialogue of the File menu. The PDF 
format is useful for emailing copies of a lesson that would be 
printed, while HTML is useful for including the lesson in a 
website. Finally, the Marcomedia Flash format is good for 
playing the slides on a website.

The next part of this book will cover the internet and some 
of the many Free Software tools that will help you create 
your own website. But I will finish this part with a reminder 
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of just how much OpenOffice.org can do for you.

Further resources
● “Absolute PowerPoint” by Ian Parker. New Yorker, May 

28th 2001. A copy is available at:
www.physics.ohio-
state.edu/~wilkins/group/powerpt.html 

● Microsoft education resources – 
www.microsoft.com/Education/ 

● “The Cognitive Style of PowerPoint” by Edward Tufte. 
Graphics Press 2003. ISBN 0961392150.
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“If all you have is a hammer, everything looks like a 
nail.” Anonymous

In 1891 Victorinox began supplying the Swiss Army 
with pocket knifes. The company now produces over 
22,000 Swiss Army knives per day most of which are 
for export. Around the world many people have come 
to depend on these knives for their versatility.

OpenOffice.org is even more versatile. In this chapter I 
hope to give you some ideas that show off more of its 
abilities.

Writer has everything you need for 
writing your own book
I wrote this book using OpenOffice.org Writer. Many 
features made the software an excellent choice. For 
example, the Indexes and Tables... command 
automatically generated the table of contents for the 
book. As I added, deleted and reorganised chapters, 
Writer adjusted the table of contents and kept track of 
the page numbers.

The command also created the index at the back of the 
book. All I had to do was identify individual ideas as 
important enough to include in the index using the 
Entry... command.

As the book increased in size I decided to divide it into 
separate files for faster loading and easier backing up. I 
used the Master Document command to create a single 
file that collated the other files. Writer automatically 
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renumbered the pages, figure captions and entries in the 
table of contents and index across all of these files.

I exported the result into a single PDF file. I could provide 
this to any printer and be sure that the output would be 
exactly as I had intended. I had done this using Microsoft 
Word and Adobe Acrobat when I wrote and published my 
first book, “Handhelds for Doctors”16.

Figure 16: OpenOffice.org's PDFs include bookmarks

What impressed me with OpenOffice.org was that the 
exported PDF included Adobe Reader-compatible features 

16 This was the self-published edition of the book that was 
eventually published by John Wiley & Sons, Ltd, under the title 
“Handheld Computers for Doctors”.
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like Bookmarks. This adds a professional touch to the 
electronic book and makes for a pleasant reading experience. 
Doing this with Word and Acrobat is difficult and time-
consuming but Writer handled the job beautifully and 
automatically (see Figure 16).

Academic authors will also appreciate Writer’s formulae and 
bibliography features. The Formula feature is powerful, 
allowing the insertion and manipulation of many 
mathematical symbols.

Unlike Word, Writer also includes a bibliography manager, 
accessible as the Bibliography Database from the Tools 
menu. This feature is particularly worth watching, as with 
the release of Version 2 of OpenOffice.org development of 
more advanced bibliographic tools has begun17.

In fact the release of this version also heralds development 
of lots of other tools because OpenOffice.org is built on 
XML18. For software developers and enterprises this means a 
transparent foundation on which to build quickly extensions. 
For you and me it means a wealth of more powerful tools is 
on the way.

But enough about text – OpenOffice.org can also handle 
drawings.

Drawings with OpenOffice.org
Impress is surprisingly good for layout design. The Toolbars 
submenu from the View menu lists several useful toolbars. 
These include the Drawing toolbar that appears at the bottom 
of the screen by default, but also the 3D-Objects, Circles and 
Ovals, and other toolbars. On a blank slide with no layout 

17 http://bibliographic.openoffice.org/   

18 http://xml.openoffice.org/   
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you can use all the text, shapes and colours that you need for 
your drawing.

OpenOffice.org Draw is a more specialised tool that has no 
equivalent in Microsoft Office. You can access it by 
choosing New then Drawing from the File menu.

Use the Page... command from the Format menu to select a 
different layout for the page. For example, you can choose a 
much larger page for a poster, or a square one for a birthday 
card.

When your drawing is finished, the Export... command will 
create something appropriate for your publication medium. 
For the large poster example, PDF is what your printer will 
expect from you. If you are publishing for the web the 
HTML Document option creates a web page while the PNG 
option creates an image that you can use in other web pages.

You can use any of your OpenOffice.org Draw documents in 
any of your other OpenOffice.org documents. This even 
works in OpenOffice.org Base.

OpenOffice.org Base creates databases 
as Microsoft Access does
The most significant improvement in OpenOffice.org 2.0 is 
the addition of Base because it allows you to create 
databases.

A database is an electronic version of a filing cabinet 
containing paper forms. Like the filing cabinet you can use it 
to store the forms for safe keeping, and see the data entered 
in each form whenever you need. You can also add more 
data by completing a new form and adding it to the store.

But because it is electronic, a database has many advantages 
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over filing cabinets. First, it sorts the data quickly and in as 
many ways as you want it to. For example, you can sort a 
database of your friends’ birthdays by the last name of each 
of them, or their birthday, or both. The forms can also be 
faster to complete. For example, a database form with 
addresses can include a drop-down list of countries. 
Choosing from these can be faster than writing the country 
name. More importantly, you can guarantee that everyone 
who fills out the form will have spelt the country correctly 
because they chose from your correctly spelt list.

With a little programming, Base can be very powerful. For 
example, when the user types in the zip code the database 
can automatically deduce the city and state.

The programming aspect means that most of us will leave 
the design of databases to someone with formal computer 
training. What you need to tell this member of your team is 
that Base is a relational database with Forms and Reports, 
that it can connect to any ODBC datasource, including 
MySQL databases and that it handles SQL queries.

In other words, Base matches Microsoft Access in features, 
but is available free of charge.

Meanwhile, what you need to know is that Base is powerful 
and useful. Whenever you find yourself and your team 
filling out a form more than a few times, think of using Base. 
Whether you want to store your church’s membership, your 
clients’ addresses, your patients’ cancer diagnoses, or your 
city residents’ property tax valuations, consider using Base 
as part of the solution.

I hope that by now you have understood some of the power 
of OpenOffice.org and the implications of having this power 
free of charge. The next part will show you that such power 
and price is available in many other examples of Free 
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Software.

Further resources
● OpenOffice.org Bibliographic Project – 

http://bibliographic.openoffice.org/ 

● OpenOffice.org XML – http://xml.openoffice.org/ 
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Part II
Internet tools

If you have ever used Google (www.google.com) to 
search the internet, then you have relied upon Free 
Software.

That is because Google's website runs on tens of 
thousands of computers and each of these is using the 
GNU/Linux operating system and the Apache web 
server.

Google's scientists have stated many times that only 
Apache and GNU/Linux can provide the stability and 
security required to serve the millions of web users 
every day. And only with Apache and GNU/Linux 
could they have afforded to buy so many scores of 
thousands of computers.

That is why Google, Amazon, Yahoo!, eBay and 
numerous other companies depend on Free Software. In 
fact, almost 70% of websites are run using the Apache 
web server Free Software and the computers of many 
websites use Free operating systems like GNU/Linux or 
BSD Unix19.

Your organisation does not need to have as many 

19 http://news.netcraft.com/archives/web_server_survey.htm  
l 
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customers as Google does to be able to benefit from Free 
Software's internet tools. The fact is that the free cost of Free 
Software means that everyone can afford to use it. And as 
this part of the book will show you, the Free tools available 
are often superior in quality to commercial software.
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“I suggest dumping Microsoft's Internet Explorer, 
which has a history of security breaches. I recommend 
instead using Mozilla Firefox. It’s not only more secure 
but also more modern and advanced, with tabbed 
browsing and a better pop-up ad blocker.” — Walt 
Mossberg, Wall Street Journal, September 16th 2004.

In the preface I mentioned that one of the advantages of 
Free Software is that it breaks monopolies and that that 
is a good thing. Web browser software is a great 
illustration of this point.

The world wide web was literally invented by Tim 
Berners-Lee, a British physicist working at CERN, the 
world's largest particle physics laboratory. Sir Tim, 
who received a knighthood in 2004 for his efforts, 
created a standard for web pages and designed software 
for looking at those pages. The standard that he created 
was brilliant because it made writing web pages so 
easy. His software was not so brilliant, but Sir Tim 
made sure that anyone else could write software for 
browsing and creating pages. In fact, he deliberately 
refused to make money from his world wide web so 
that other developers would be free to create better and 
better software tools.

This worked magnificently and one of the first 
companies to take advantage of the web was Netscape. 
Their browser software was powerful and free of 
charge for non-commercial users. In the mid-1990s, up 
to 90% of people reading web pages were doing so 
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with Netscape's web browser20.

In 1995, Microsoft launched its own web browser, Internet 
Explorer21, which was initially inferior to Netscape's. 
However, Microsoft could afford to give the software away 
free of charge because it was making so much money from 
Windows and Office software. Furthermore, it included 
Internet Explorer with Windows and made it the default 
browser. Today around 90% of web users do so with Internet 
Explorer.

This does not mean Internet Explorer is the best browser. In 
the last few years features like tabbed browsing and 
integrated customised searching and themes have 
dramatically improved the experience of browsing the web. 
However, Microsoft has not added any of these to Internet 
Explorer.

Furthermore,  Internet Explorer has been downright 
dangerous, exposing computers to attacks. These dangers 
drove the governments of the USA22 and Germany23, as well 
as several security companies, to advise against using 
Internet Explorer.

There are several reasons for this state of affairs. First, the 
incentives: Microsoft does not make any money from you 
when you use its web browsing software, its only interest 
being to to ensure that other web browser companies pose no 
threat to its monopoly. Because they have achieved this, 
obtaining 90% market share, they have no further incentive 
to improve the software.

20 http://en.wikipedia.org/wiki/Netscape_Navigator   

21 http://en.wikipedia.org/wiki/Internet_explorer   

22 http://www.kb.cert.org/vuls/id/713878   

23 http://www.theregister.co.uk/2004/09/13/german_ie_jitters/   
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Companies like Opera (www.opera.com) sell web browser 
software, so they are constantly adding features because they 
must constantly fight for income.

Second, many of the security risks risks come from a similar 
problem of incentives. At the time that Microsoft was trying 
to beat Netscape, they added features like ActiveX to 
Internet Explorer that allowed them to advertise capabilities 
that Netscape could not match. Netscape could not match 
these because the features depended on having direct access 
to the Windows code. But ActiveX had significant security 
risks24. Microsoft advertised the features despite the risks.

The advertising is gone, because Netscape's threat is gone, 
but on millions of PCs today the security risks remain.

Finally, Microsoft simply cannot do everything right because 
no one can be so perfect. It only has so many software 
developers, they can only spend so much time analysing 
their code for security risks and they only have so much 
expertise about security.

This chapter is about Mozilla Foundation's approach to web 
browsers and its product, Firefox (www.mozilla.org/firefox). 
The Foundation funds developers who are passionate about 
web browsing software. The tools are further checked by 
people from all over the world who are also passionate about 
browsing software. All these people use Firefox. If there is a 
problem with the software they know about it soon and they 
fix it soon after. They depend on the software being of high 
quality, which is why they have an incentive to fix it.

Second, the developers were concerned about security from 
the start. They lay the foundations for good security in their 
software because the it will be used by important people in 
mission-critical projects.

24 http://www.cs.princeton.edu/sip/faq/java-vs-activex.html   
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Furthermore, the code that they produce is available for 
everyone to see. The paradox of security is that by exposing 
every security hole it is easier to ensure security – experts 
around the world are constantly scrutinising Firefox code 
and pointing out deficiencies. On the other hand this should 
not surprise us.

The democracies of the West flourished while the 
Communist states of the Soviet Union collapsed because the 
democracies shared information with their citizens, not 
despite it. Transparency encourages security.

Finally, by making the code available to everyone, it is much 
easier to build good extensions to the code. The rest of this 
chapter will show you these tools and end with technical 
explanations of how to get them and use them.

But the main point for now is that the monopoly is breaking 
and that is good for users of the web. Every week brings 
more articles praising the superior quality of Firefox versus 
Internet Explorer. Every week more computer users decide 
that using the web is faster, more powerful and simply more 
pleasant when using Firefox. And every week decision 
makers in governments, companies and organisations make 
the decision that the security of their computer network 
depends on using Mozilla's software.

Microsoft will simply have to respond by improving the 
quality and security of Internet Explorer. All computer users 
will be winners from such improvements. Until that day, you 
can benefit by switching to Firefox.
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Examples
Ms Yates searches Google, uses tabs and avoids pop-up 
windows (page 68)

Mr Salah Al-Din searches for meaning (page 69)

Dr Digitalis searches PubMed (page 70)

M. Braille downloads entire websites (page 72)

Mr Big's team improves security, creates bookmarks and 
designs a theme (page 73)

Ms Yates searches Google, uses tabs 
and avoids pop-up windows

Firefox makes searching easy. Rather than 
visiting Google to begin a search, type your 
search text into text area in the top right 
corner of Firefox (see Figure 17) and press 
the return key. Firefox will show you the list 
of results from Google. The tabs feature 

allows you to study these results quickly.

Figure 17: The search bar is in the top right corner of Firefox

Ms Yates typed “handheld computer accessories” into the 
search bar. She decided that the first ten companies in the list 
would be the the most important source of competition or 
partnerships.

With the right mouse button, she clicked on the title of the 
first website, then with the left mouse button she clicked on 
Open Link in New Tab. At the top of Firefox, a tab appeared 
with the title of that website. She repeated this for the next 
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nine websites and nine new tabs appeared for the websites 
(see Figure 18).

Figure 18: Opening multiple tabs from Google search results

By clicking on the title of each tab, she could see each 
company's website. Comparing different companies' sites by 
clicking on the different tabs was easy and quick.

Firefox was a particularly good time saver when Ms Yates 
connected to the internet through her laptop's dial-up 
modem. She frequently had to do this while travelling, which 
meant that she was often in a hurry, but that she had a slow 
internet connection. By opening multiple tabs for browsing, 
she found that by the time she had finished reading the text 
of the web page of the first tab, the text of all the other tabs' 
web pages had finished loading.

This is because Firefox works efficiently on multiple tasks, 
like loading other tabs, even as it remains responsive to your 
main task, which is reading a particular web page. It also 
avoids wasting time by blocking the windows that pop up on 
some sites, often called pop-up windows. These are almost 
always advertisements and Ms Yates was delighted that she 
was no longer bothered by them.

Mr Salah Al-Din searches for meaning
Google is not the only search engine that 
Firefox offers. Click on the  icon to see 
a list of alternatives included with Firefox 
and click on Add Engines... to see a huge 
and expanding list of other search engines 
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you can add.

Mr Salah Al-Din was delighted to find the Wikipedia 
(www.wikipedia.org). It meant that he could search this 
encyclopaedia from the top right-hand corner of Firefox. 
There were all sorts of other encyclopaedias for him to 
choose from, including HowStuffWorks 
(www.howstuffworks.com) and Microsoft Encarta 
(http://encarta.msn.com/).

He also found a list of dictionaries, from which he chose the 
Wiktionary (www.wiktionary.org). Others on the list 
included the Cambridge Dictionary 
(http://dictionary.cambridge.org) and the Merriam-Webster 
Thesaurus (www.merriam-webster.com). He made sure that 
all of the students' PCs had the encyclopaedia and dictionary 
searches added.

Dr Digitalis searches PubMed
PubMed (www.pubmed.gov) provides the 
abstracts of the papers from most modern 
biomedical journals. It is run by the US 
government's National Center for 
Biotechnology Information (NCBI).

Dr Digitalis had found it an invaluable 
resource when dealing with unusual clinical problems 
because she could find the very latest papers that could help 
answer her questions.

Using the Add Engines... feature she added NCBI PubMed 
to her search engines, speeding up her PubMed searches.
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She also found PubMed Central25 and PubMed Books26 as 
search engines for other NCBI tools. The first allowed 
searching papers for which the entire text was available. This 
was very useful because her private practice had not yet 
subscribed to many journals, which had previously meant 
that Dr Digitalis could read only the abstracts for free and 
would have to request the full copies from her local medical 
library. Searching PubMed Central meant that any papers 
that did appear would instantly be available free of charge.

PubMed Central makes all these papers available because 
the journals that published them did so under an Open 
Access licence (www.doaj.org).

This is the publishing world's equivalent to Free Software, 
because it means that there are no restrictions on the viewing 
and redistribution of the digital version of the papers. In 
2004 the US Congress passed legislation so that papers from 
any research that received Federal funds would be made 
available through PubMed Central in this way. The UK's 
Parliament is also looking at similar legislation for British 
science, as are the governments of Germany, France and 
Japan.

Dr Digitalis found that the NCBI Bookshelf (“PubMed 
Books”) also provided an incredible amount of free 
biomedical information, but in the form of textbooks. For 
example, the HSTAT series of textbooks27 provided US 
government guidelines on the treatment of a wide range of 
diseases.

She frequently used the PubMed Books search engine to 

25 www.pubmedcentral.gov  

26 http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?db=Books   

27 http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv.View..Sho  
wTOC&rid=hstat.TOC&depth=2 
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look up biological terms with which she was not familiar. 
This led her to textbooks like Stryer's Biochemistry28 and 
Baron & Samuel's Medical Microbiology29 because they 
covered areas of medical science that were not her strongest. 
To her surprise, the books were well-written and actually 
enjoyable to read, a refreshingly different experience from 
her early years at medical school.

M. Braille downloads entire websites
Like Mr Salah Al-Din, M. Braille added the 
Wikipedia search engine to the top right 
corner of Firefox, but he used the French 
version of the encyclopaedia 
(http://fr.wikipedia.org).

However, his students could not use the 
encyclopaedia, nor even the web in general, because the 
school did not have internet access.

M. Braille could use the internet in his home through his 
own PC and phone line. When he found a page that would be 
useful for his lessons, he selected Save Page As... from the 
File menu and Firefox would save a copy of the page on his 
floppy disk. M. Braille would then take the disk to school 
and copy the page from the disk to every computer.

He was careful to only do this from sites that gave 
permission. He found many sites, like the Wikipedia, which 
used the GNU Free Documentation License, which gave him 
all the freedom he needed to make copies in this way.

28 http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv.View..Sho  
wTOC&rid=stryer.TOC&depth=2 

29 http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv.View..Sho  
wTOC&rid=mmed.TOC&depth=2 
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But soon he found that he wanted several related pages from 
each site and the process of saving each individual page was 
lengthy and burdensome.

Spiderzilla (http://spiderzilla.mozdev.org) is an Extension 
that solves this problem. By clicking Download this site 
from the Tools menu, M. Braille could download entire 
websites onto his computer. He could then copy these onto 
the computers at the school and the children could browse 
around the sites without needing internet access.

Mr Big's team improves security, 
creates bookmarks and designs a 
theme

Mr Big's Chief Technology Officer was 
relieved when the IT department installed 
Firefox on all the PCs in all the hotels. 
Using Firefox rather than Internet Explorer 
removed several important security threats. 
It also saved the time of IT department staff 

who were having to constantly keep up with Microsoft's 
security patches for Internet Explorer and ensure that all of 
them were installed on all PCs.

With this security risk removed, the CTO felt more confident 
about his plan to provide computers for customers in all of 
the hotel lobbies. He wanted customers to be able to use the 
machines to get information about their hotel and about the 
local area.

To achieve this, the IT staff changed the default starting web 
page for Firefox in each hotel. They selected Options... from 
the Tools menu and clicked on General. Under Home Page, 
they typed in the web address for the hotel chain's website, 
then clicked the OK button.
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This meant that when a customer began browsing the web on 
a PC in the hotel lobby, the first web page to appear would 
be the hotel's. If the customer wanted to get back to that 
page, they could just click the  icon.

The IT staff also taught the hotel staff how to add bookmarks 
that would be useful to customers wanting to learn about the 
local area. For example, the Washington Post's local events 
page is useful for hotels in the Washington, DC area. The 
easiest way was to visit the right web page, then click 
Bookmark This Page... (see Figure 19). The customer could 
visit that web page again by clicking on the Bookmarks 
menu and then on the web page's name.

The Themes feature in Firefox allows changing the colours 
and icons of the web browser. Selecting Get More Themes 
shows a list of freely available themes. Creating a theme 
takes a little more work, but the MozillaZine website 
provides clear explanations and examples30.

Figure 19 Adding a bookmark

Naturally, the marketing department wanted to use this for 
branding. Soon the hotel had its own Firefox theme and it 

30 http://kb.mozillazine.org/Dev_:_Themes   
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was installed on all the machines in the lobby.

Further resources
● Mozilla Firefox – www.mozilla.org/firefox 

● Opera – www.opera.com 

● Google – www.google.com

● Wikipedia – www.wikipedia.org 

● HowStuffWorks – www.howstuffworks.com 

● MSN Encarta – http://encarta.msn.com/ 

● Wiktionary – www.wiktionary.org 

● Cambridge Dictionary – http://dictionary.cambridge.org/ 

● Merriam-Webster Thesaurus – www.merriam-
webster.com 

● Website for this book – www.freedomsoftware.info 

● PubMed Central – www.pubmedcentral.gov 

● NCBI Bookshelf – 
http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?db=Books 

● Dictionary of Open Access Journals – www.doaj.org 

● “Health Services/Technology Assessment Text 
(HSTAT)”, National Library of Medicine 2003. – 
http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv.View
..ShowTOC&rid=hstat.TOC&depth=2 

● “Biochemistry” by Berg, Tymoczko & Stryer. WH 
Freeman & Company 2002. ISBN 0716746840. 
http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv.View
..ShowTOC&rid=stryer.TOC&depth=2 
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● “Medical Microbiology” by Baron, Samuel. University of 
Texas 1996. ISBN 0963117211. 
http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv.View
..ShowTOC&rid=mmed.TOC&depth=2 

● MozillaZine article about creating themes – 
http://kb.mozillazine.org/Dev_:_Themes 
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According to Grant Thornton's 2005 International 
Business Owners Survey the average US business 
owner spends two hours every day using email. Nor is 
this the highest average – business owners in the 
Philippines reported spending 2.1 hours per day. They 
were also highly optimistic about the internet, 84% of 
them reporting that the internet had increased their 
revenues. The French view was more sceptical, only 
13% responding so positively about the internet. 
However, they still spent close to one hour per day 
using email31.

Whether you are of the French or the Filipino school of 
thought, it is clear that the internet has an important 
role to play in our institutions and many of us spend a 
significant part of each day reading and writing emails. 
Given this popularity it is no surprise that spammers 
have targeted email as a way to reach millions of 
people cheaply.

What is surprising is how long so many people tolerate 
using email software that is vulnerable to viruses. 
Microsoft's Outlook and Outlook Express are by far the 
most popular software tools for email, but they have 
also been the reason for the spread of the most 
devastating viruses. Sasser, Blaster, Nachi and Sobig 
were notorious names in the last two years, affecting 
literally millions of machines around the world.

Of course part of the reason for their creation is that 

31 "Email". Economist March 3rd 2005. 
www.economist.com/markets/displayStory.cfm?story_id
=3722779 
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malicious creators of computer viruses target the most 
popular software to cause the most damage. But the other 
component is that Microsoft had made some uniquely bad 
security decisions32 in the past and the users of Outlook and 
Outlook Express have suffered because of this.

Email does not have to be this way – and Mozilla's Free 
Software gives you impressive alternatives 
(www.mozilla.org/thunderbird).

32 For example, see: 
http://pcworld.about.com/magazine/1910p059id57963.htm 
http://news.com.com/2100-1023-866307.html?legacy=cnet and 

http://secunia.com/advisories/11067/ 
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Examples
Dr Digitalis switches to Thunderbird and imports her old 
email messages (page 79)

Mr Salah Al-Din switches from POP to IMAP for accessing 
his email at home (page 81)

Mrs Shrub reads the news with RSS (page 82)

M. Braille filters out his spam mail (page 85)

Ms Yates uses extensions (page 87)

Mr Big uses Mozilla suite (page 88)

Dr Digitalis switches to Thunderbird 
and imports her old email messages

The Thunderbird installer automatically asks 
you if you want to import your old email 
messages and settings. It can import data 
from Outlook, Outlook Express and Eudora, 
as well as other email software from 
Mozilla.

This was a great relief to Dr Digitalis as she was worried 
about her old messages. Because she had so many old 
emails, the process took about half an hour.

After this, however, Thunderbird was quite fast. In fact 
Thunderbird indexes all email messages in advance so that 
searching through them is much faster than with Outlook or 
Outlook Express. You can quickly find an email by a 
particular person, or with a particular phrase in the subject, 
by typing next to the  icon.
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Figure 20: Thunderbird stores your email in the "Documents and 
Settings" folder under your profile.

Finally, Dr Digitalis was relieved at how easy it is to back up 
messages. As Figure 20 shows the Dr Digitalis folder is 
insider her computer's Documents and Settings folder. This 
contains the Application Data folder, which contains the 
Thunderbird folder, which in turn contains all her emails. 
Making a backup copy of this folder meant that all her 
messages were backed up.

This method is good for several reasons. First, the folder 
itself is easy to find – Outlook Express and Outlook use 
cryptic names for their storage. Second, Outlook stores the 
messages for each user in just one file. If any message in that 
file is corrupted, the whole of the file – and all the messages 
it contains – can no longer be opened. Because Thunderbird 
creates a folder on your computer for each message folder 
that you create in Thunderbird from the File menu.

Third, backing up a folder to a CD can be easier. If the size 
of a file exceeds that of your backup medium (around 700 
MB for a CD) splitting up that file is complicated. Because 
Thunderbird uses a folder that contains several smaller files 
and folders, it is more likely that each of these files will fit 
inside your backup medium.
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Mr Salah Al-Din switches from POP to 
IMAP for accessing his email at home

Thunderbird can connect to POP and IMAP 
email servers. POP stands for Post Office 
Protocol and is a common method for 
managing email within an organisation. 
Commercial email accounts from companies 
like Yahoo! and Google also provide POP 

servers for their customers.

Mr Salah Al-Din had a computer at home that he used to 
check his email outside of school hours. Initially, he had set 
up Thunderbird so that it connects to the school's POP 
electronic mail server.

However, the default for Thunderbird and most email 
software is to remove email from a POP server. In other 
words every time Mr Salah Al-Din clicked the Get Mail 
button, Thunderbird downloaded messages from his POP 
server to his computer then deleted the messages on the POP 
server. This is useful for saving space on the POP server.

However, for Mr Salah Al-Din this was a major 
inconvenience – as soon as he checked his email on his 
home PC it would not be available the next day on his work 
PC. And at home he could not access any of the messages 
that had been downloaded to his PC at work earlier during 
the day.

Initially the solution was to switch off the deletion using the 
Account Settings item from the Tools menu.

However, an even better solution was possible when the 
school switched to using IMAP (Internet Message Access 
Protocol) rather than POP for running the email server. First, 
almost as soon as an email arrived for Mr Salah Al-Din on 
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the school's email server, it appeared on the PC he was 
using. He no longer needed to click the Get Mail button.

Second, the message was not deleted from the server when it 
appeared on his computer – rather, Thunderbird gave Mr 
Salah Al-Din direct access to what was on the server. This 
meant that the messages that Mr Salah Al-Din read in the 
evening on his home PC were available for him to see the 
next day on his work PC.

In addition, the Thunderbird interface on both machines 
indicated which messages he had already read, because their 
titles were not in bold text (see Figure 21). The  icon 
showed which messages he had replied to the night before.

Figure 21: Thunderbird uses bold text to indicate messages 
that have not yet been read

In fact, Thunderbird keeps a copy of the messages sent on 
the IMAP server, so no matter which computer Mr Salah Al-
Din used for sending and receiving his messages he would 
always be able to see all of these messages.

Finally, he installed Thunderbird onto his laptop. The 
Account Settings dialogue included an option to keep an 
offline copy of the mail from the IMAP server. This allowed 
Mr Salah Al-Din to see his old email messages even while 
not connected to the internet.

Mrs Shrub reads the news with RSS
Thunderbird offers a useful way of getting 
the news. This is because many websites 
offer RSS versions of their news stories and 
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Thunderbird can use RSS to collect those stories. RSS stands 
for the Really Simple Syndication, but the name belies the 
power that it offers and the professionalism of the 
organisations that offer it.

Mrs Shrub liked to start her day by reading the newspapers 
while watching the BBC's news on TV. She was intrigued to 
learn that the BBC offers RSS feeds from its news site33 (see 
Figure 22).

To use RSS, look out for the  icon in Firefox. Click on 
it with the right mouse button and select Copy Link 
Location. In Thunderbird, click on Manage Subscriptions, 
then Add and paste the address of the link you copied in 
Firefox. After you click the OK button Thunderbird begins 
downloading the stories.

As soon as the BBC published a new story, it would appear 
on Mrs Shrub's RSS account in Thunderbird. The BBC site 
also offers several news categories, from which she selected 
“News Front Page”, “UK”, “Business” and “Politics” (see 
Figure 22).

Other sites offer an even greater choice. For example, 
Moreover34 provides over 330 news categories, including 
“Top UK stories”, which collects stories from the UK's 
newspapers.

Once she understood the significance of the  icon Mrs 
Shrub began spotting it everywhere, including the websites 
of CNN35 and The New York Times36. Some consulting 

33 http://news.bbc.co.uk/2/hi/help/3223484.stm   

34 http://w.moreover.com/new/other/categories_rss.html  

35 www.cnn.com/services/rss/  

36 www.nytimes.com/services/xml/rss/  
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companies, like the Oxford Business Group37, used the  
icon instead.

Figure 22: The BBC's news site makes RSS feeds available at  
http://news.bbc.co.uk/1/hi/help/rss/3223484.stm 

This is the icon that she found on many blogs – online 
diaries – that she enjoyed reading. One of these was the 
blog38 of Margot Wallström, the Vice-President of the 
European Commission. Her site had developed a loyal 
readership and seemed a public relations triumph. Mrs Shrub 
wondered if she could create a similar blog to reach her 
voters in London.

37 www.oxfordbusinessgroup.com  

38 http://weblog.jrc.cec.eu.int/page/wallstrom  
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M. Braille filters out his spam mail
Sadly, having an email address means 
receiving junk emails. However, when 
Thunderbird collects your email messages 
you will notice that many of the spammers' 
messages have a  icon. This is 
Thunderbird's Junk Mail Control... at work.

However, not all the junk messages will have the icon. 
Select each of these and click the Junk button at the top of 
the window. Conversely, some messages will have been 
identified wrongly as junk mail. Select each of these and 
click the Not Junk button.

Although M. Braille received many messages every day 
from family, friends and co-workers, he received even more 
junk messages from spammers. After a few days of manually 
overriding the junk status that Thunderbird had assigned to 
each of his messages he noticed that the program's accuracy 
was improving.

This is because the junk mail feature changes its rules to 
match more closely the judgement of the user. It also refrains 
from labelling as junk mail any messages that come from 
email addresses that are already contained in your address 
book.

Thunderbird has a subtle feature for blocking the efforts of 
spammers – it does not automatically show the pictures in an 
email if the picture was not included with the email. This is 
because some spammers simply include a reference to a 
picture in the mass emails that they send out. Some email 
software automatically follows those references, connecting 
to the internet to get a copy of the pictures and then 
displaying it. However, as soon as the software connects to 
the internet it confirms to the spammer that the email address 
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is a legitimate one. The spammer targets confirmed email 
addresses even more strongly.

By not automatically following such references Thunderbird 
prevents the confirmation that spammers thrive on. The 
Show Images button allows manual overriding in each 
message (see Figure 23).

Figure 23: To protect against spammers Thunderbird does 
not automatically show remote images. Click the "Show 

Images" button to override this.

Soon M. Braille trusted the software enough – it did not 
label everything correctly as junk mail, but it stopped 
incorrectly labelling any of his legitimate messages as junk 
mail. From the Tools menu he selected Junk Mail Controls... 
and switched on automatic message handling. This meant 
that Thunderbird automatically moved junk mail messages to 
a separate folder, clearing his Inbox.

Inspired by this automation M. Braille began reading about 
the Message Filters... command in the Tools menu. This 
allows setting rules for handling new messages.

He added a rule so that Thunderbird automatically moved 
every message from his colleagues at the charity to a folder 
he called “Charity”. He created another folder called “Lit-
Ideas”. This was for messages that he received from the Lit-
Ideas mailing list39, an entertaining discussion list for 
university professors in the humanities to discuss the impact 
of technology. Every message that came from the list 
included “[lit-ideas]” in the subject. M. Braille created a 
filter that automatically identified these messages by their 
subject and copied them to the “Lit-ideas” folder.

39 www.freelists.org/list/lit-ideas  
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Ms Yates uses extensions
Ms Yates had used several extensions for 
Firefox. She was delighted that extensions 
were also available for Thunderbird from the 
Tools menu.

The first extension that she installed was a 
dictionary40 – this allowed her to look up the definitions of 
technical words in her messages.

Another extension allowed her to control her iTunes music 
player and most other music players, including the Free 
Software Zinf41. This was important because she spent a lot 
of time every day reading and writing her emails and she 
liked to do so with music playing in the background. The 
extension's controls were available in every Thunderbird 
window, meaning that she could fast-forward, rewind, pause, 
play and change the volume without switching away from 
the message she was reading. Another version of the 
extension gave her the same controls on Firefox as well42.

New extensions are always being added and Ms Yates 
wanted to keep track of all them. She found the Mozilla 
Foundation's RSS feed about new extensions43.

40 https://addons.update.mozilla.org/extensions/moreinfo.php?id=  
68&application=thunderbird 

41 https://addons.update.mozilla.org/extensions/moreinfo.php?id=  
219&application=thunderbird 

42 https://addons.update.mozilla.org/extensions/moreinfo.php?id=  
219&application=firefox 

43 https://addons.update.mozilla.org/rss/?application=thunderbird  
&type=E&list=newest 
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Mr Big uses Mozilla suite
One of the key strengths of Microsoft 
Outlook is its calendar. This feature is not 
included in the default installation of 
Thunderbird. Several Free Software options 
are available.

One is to use Thunderbird's extensions. For 
example, the Mozilla Calendar extension44 adds a Calendar 
command to the Tools menu. The calendar icon can also be 
added to the toolbar (see Figure 24). The PalmSync 
extension45 further strengthens Thunderbird's address book 
by allowing its synchronisation with Palm Powered handheld 
computers.

Figure 24: The Calendar extension's icon can be added by right-
clicking onto the toolbar and selecting Customize...

However, other Free Software tools are available that were 
designed with calendar integration as a key feature rather 
than an afterthought. For example, the Open Source 
Application Foundation is creating Chandler 
(www.osafoundation.org), with an impressive vision for 
personal information management. However, it is still under 
development and a stable version is not yet available.

On the other hand Ximian Evolution is mature software that 
is similar to Outlook in functionality and user interface but 
superior in security (www.ximian.com). It also integrates 

44 http://www.mozilla.org/projects/calendar/  

45 http://kb.mozillazine.org/Thunderbird_:_FAQs_:_PalmSync  
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into the Microsoft Exchange email server, allowing group 
calendar functionality. However, it is only available for 
computers running GNU/Linux, not Windows.

In the end Mr Big chose the Mozilla Suite 
(www.mozilla.org/products/mozilla1.x/), after which the 
Mozilla foundation was originally named. Its integration is 
even greater than Outlook's, combining web browsing, email 
handling, RSS reading, calendar functionality and web page 
creation.

And because it is based on the Mozilla Foundation's 
technology, it can use the same extensions that are available 
for Firefox and Thunderbird.

Further resources
● Mozilla Thunderbird – www.mozilla.org/thunderbird 

● BBC News RSS feeds – 
http://news.bbc.co.uk/2/hi/help/3223484.stm 

● Moreover news RSS feeds – 
http://w.moreover.com/new/other/categories_rss.html 

● CNN RSS feeds – www.cnn.com/services/rss/ 

● New York Times RSS feeds – 
www.nytimes.com/services/xml/rss/ 

● Oxford Business Group – 
www.oxfordbusinessgroup.com 

● Margot Wallström's blog – 
http://weblog.jrc.cec.eu.int/page/wallstrom 

● DictionarySearch extension – 
https://addons.update.mozilla.org/extensions/moreinfo.ph
p?id=68&application=thunderbird 
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● FoxyTunes extension for Thunderbird – 
https://addons.update.mozilla.org/extensions/moreinfo.ph
p?id=219&application=thunderbird 

● FoxyTunes extension for Firefox – 
https://addons.update.mozilla.org/extensions/moreinfo.ph
p?id=219&application=firefox 

● Thunderbird new extensions RSS feed – 
https://addons.update.mozilla.org/rss/?application=thunde
rbird&type=E&list=newest 

● Calendar extension – www.mozilla.org/projects/calendar/ 

● PalmSync extension – 
http://kb.mozillazine.org/Thunderbird_:_FAQs_:_PalmSy
nc 

● Open Source Application Foundation Chandler – 
www.osafoundation.org 

● Ximian Evolution – www.ximian.com 

● Mozilla Suite – www.mozilla.org/products/mozilla1.x/ 
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In 2004, King Sihanouk of Cambodia abdicated his 
throne46. The world and his parliamentarians, found out 
about this through his personal website 
(www.norodomsihanouk.info). During 2003, Salam 
Pax (http://dear_raed.blogspot.com/) described to 
readers around the world his daily experiences during 
the fighting between the US and Saddam's army. And 
in 2005, BoingBoing (www.boingboing.net) continues 
to fascinate as “a directory of wonderful things”.

A website is a great way to share information with 
others around the world.

To create a website, you need three things. First, you 
need content in the form of webpages. Writing a 
webpage is simpler than writing a word processing 
document, so if you are comfortable with 
OpenOffice.org Writer then you will find creating a 
webpage is easy.

Second, you need a computer to store the webpages for 
your readers. This is called a webserver. Running your 
own webserver is expensive and can be a full-time job. 
But renting a webserver is easy and affordable and 
some companies even offer the service free of charge. 
The companies that rent out parts of their webserver to 
host your website are called webhosts.

Third, you need a web address so that other people 
using the web can find the webserver containing your 
webpages. Examples of web addresses include 
www.freedomsoftware.info for this book. The address 
also allows others to email you. For example, you can 

46 www.economist.com/displaystory.cfm?story_id=311462  
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email me at mo@freedomsoftware.info.

The costs of these steps are constantly dropping, the ease of 
starting is constantly improving and this chapter will 
demystify the basics.

What is most important to learn from this chapter is that 
there are many possibilities for your own website. Each of 
the characters uses their site for different reasons and you 
will have reasons of your own.

It is a common reaction to feel shy about setting up your 
own website for the first time. However, we all have 
something to tell others about, whether it is our day's events 
for family and friends to read about, or our professional 
expertise for colleagues to learn from.

You may feel scared about the risks and workload of your 
website and you are right to think ahead. There are four 
points to mention. First, avoid putting information on the 
internet that you do not want everyone to learn about. It is 
possible to secure your website so that only certain users can 
read it, but this takes some knowledge and is never without 
risks. So stick to sanitised information, at least at the start. In 
other words, do not broadcast your love life, or your 
complaints about your boss. On the other hand these topics 
make for some of the most charming and compelling reading 
material on the web and in time you will gain the confidence 
to discuss them in a way that minimises the risks to you.

Second, running a webserver is often a full-time job because 
of the constant attacks from malicious computer users. 
However, by renting a webserver you avoid all these 
headaches as there are professionals taking the load for you. 
On a good webhost's website you will see a guarantee of at 
least “99.9% uptime”, which means that they will ensure that 
their webserver makes your website available at least 99.9% 
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of the year. In a single year, your website will be working 
for almost every single hour of every single day, faltering for 
no more than 9 hours in total.

Third, writing for the web is different from traditional 
writing. Dr. Jakob Nielson has excellent introductory 
articles47 about this, while Dan Briklin's site provides a 
wonderful guide (www.gooddocuments.com) from a 
pioneer.

Finally, the workload of creating and maintaining a site can 
build up, especially as you come to enjoy writing and your 
website's visitors enjoy reading. On the other hand, that may 
not be a bad thing. But start with a simple site and slowly 
add content to it.

What most often astonishes new authors is how quickly the 
content on their website grows. My personal website 
(www.mo.md) began as a single article that I wrote about 
handheld computers. I began occasionally adding articles, 
until a medical company noticed it and commissioned a ten-
part series from me. Soon I had readers from around the 
world and in time I decided that I had enough material for a 
book. “Handheld Computers for Doctors” was the result 
(www.handheldsfordoctors.com).

47 www.useit.com/papers/webwriting/   
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Examples
Mr Salah Al-Din and his students use OpenOffice.org for 
simple websites (page 94)

Ms Yates uses NVU to create her company's website (page 
97)

M. Braille uses PayPal and Amazon to collect donations 
through his website (page 99)

Mrs Shrub uses CivicSpace to blog (page 102)

Dr Digitalis uses WordPress to create a blog about 
acupuncture (page 103)

Mr Big's employees use WordPress blogs to keep 
colleagues informed (page 104)

Mr Salah Al-Din and his students use 
OpenOffice.org for simple websites

To create your first webpage you only need 
OpenOffice.org. From the File menu 
selected New then HTML Document. 
HTML is an abbreviation of HyperText 
Markup Language, which is the name the Sir 
Tim Berners-Lee had given to the language 

he invented back in 1989 and all webpages are written in 
HTML.

Mr Salah Al-Din's school already had a website, but it 
consisted of just a few pages. Mr Salah Al-Din wanted to 
give each of his students some space on the school website 
so that they could express themselves and improve their 
writing skills.

Because the school already had a webserver and a web 
address, all Mr Salah Al-Din had to worry about was the 
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tools for creating the extra webpages.

OpenOffice.org HTML editor is easy to use because its icons 
are identical to those of OpenOffice.org Writer. You can 
make text bold, italicized or underlined by clicking on the 

,  and  icons respectively.

Inserting images in a document is also similar to 
OpenOffice.org Writer: select Graphics... from the Insert 
menu. However, there is one important difference. It is better 
for the image file to already be in the same folder as the 
HTML file.

You can also create hyperlinks to other webpages. From the 
Insert menu select Hyperlink. If the hyperlink is to another 
webpage in the same website, click on the Document icon on 
the left hand side, then the  icon in the top right corner 
(see Figure 25).

Figure 25 The hyperlink dialogue

For example, one student created several webpages in her 
folder, each containing a single essay. The student then 
created a single page with the titles of all the essays. For 
each title, she selected its text then inserted a hyperlink to 
the webpage with the full essay. And on every essay's 
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webpage she wrote “Home” at the top of the page and 
inserted a hyperlink to the page listing all the essays. In this 
way her parents could start with that page, click on the title 
of every essay that they wanted to read and click on “Home” 
to get back to the list when they had finished reading an 
essay.

To link to any other webpage on the internet, click on the 
Internet icon on the left hand side. Then type in the address 
of the webpage into the Target field and click the Apply 
button.

For example, another student liked to quote a lot of 
references in his essays. Many of those references were 
available on the internet, so he selected the title of each 
reference and inserted a hyperlink to the website with the 
full text. Other references were to books that were not 
available on the web, so the student created links to the 
Amazon.com pages that contained more information about 
the books. By following a link the reader would find reviews 
of the book, find out information about its publisher and buy 
it.

However, OpenOffice.org is only capable of basic HTML. 
For more sophisticated layout or advanced HTML features 
the students needed more professional HTML editing 
software. The students began reading books about webpage 
design48 and searching the internet for more information49. 
That is how they found out about NVU.

48 “Create Your Own Website (Using What You Already Know)” 
by Scott Mitchell. Sams 2004. ISBN 0672326620.

49 www.w3schools.com/html/default.asp   
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Ms Yates uses NVU to create her 
company's website

You can get a web address in ten minutes 
for less than $10 per year. Type in the name 
of your organisation as one word at www.  
godaddy.com then click the Search button 
(see Figure 26).

There are several alternative endings for 
your web address. For example, .com is for companies with 
global customers, .co.uk is for UK companies and .org is for 
non-profit organisations50.

Ms Yates bought a .com address. Within 48 hours her 
address was working. She ordered some new business cards 
that included her website and email addresses. For a 
webhost, she chose SiteGround (www.siteground.com).

A typical SiteGround account costs $60 for each year's 
service. This includes 1 GB of space, which is enough for 
detailed photographs. The performance of the site is good 
enough for starting and would cope with Ms Yates's 
expanding needs for at least the first few years.

Finally, for writing the webpages, she chose NVU 
(www.nvu.com). It allows more sophisticated page design 
than OpenOffice.org as it can handle tables51.

NVU also copes better than OpenOffice.org does with 
multiple interlinked webpages. As your site expands, you 
will rearrange and reorganise the webpages. NVU 
automatically updates the links between the pages.

50 “Getting an internet address” by Mohammad Al-Ubaydli. BMJ 
Career Focus 2005. www.mo.md/id174.htm 

51 www.w3schools.com/html/html_tables.asp   
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Figure 26: Choosing a website address (www.goddady.com)

Figure 27: SiteGround's Fantastico allows easy installation 
of many Free Software tools for your website

Finally, NVU can copy the webpages from your computer to 
your webhost's server. You will need some details from your 
webhost and SiteGround includes these in the welcome 
email you receive on setting up your account. Enter these 
details into NVU using the Edit sites button on the left hand 
side (see Figure 28).

The software is similar enough to OpenOffice.org to use 
comfortably for writing. However, designing the correct 
layout takes some more effort. The easiest way to get started 
is to use Firefox and find some websites that you like. From 
the Firefox File menu select Save Page As... to save a copy 
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of the webpage on your computer. Then Open the copy in 
NVU and customise it to suit your needs.

Figure 28: NVU

M. Braille uses PayPal and Amazon to 
collect donations through his website

Two companies make it easy to receive 
credit card payments through your website: 
Amazon (www.amazon.com) and PayPal 
(www.paypal.com). Around the world 
millions of people trust these companies to 
handle their online transactions.

M. Braille wanted to use his website to raise money for his 
charity. He bought an address ending in .org and created 
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three documents. For the first he used OpenOffice.org Writer 
to create the complete brochure about the charity with 
photographs of the children, the school and its staff. He then 
exported the document in PDF format.

For the second document he used NVU to create the main 
webpage of his website. It also contained a hyperlink to the 
PDF document that he had created and another to the 
download site for Adobe Reader52. The former link would 
allow visitors to his site to get the brochure about the 
charity's work and the latter ensured that any visitors who 
did not have Adobe Reader software could download a free 
copy before dowloading the brochure.

To handle the donation through PayPal he used his charity's 
bank account in France. He registered with PayPal's French 
site (www.paypal.com/fr/) and waited for a few days while 
the company verified his bank account details. Logging in to 
PayPal's site he was able to access its Outils marchand 
(merchant tools) section to create payment buttons (see 
Figure 29). For each button he specified the currency and 
amount of payment.

Figure 29: PayPal offers several payment buttons

Whenever a user clicks one of these buttons PayPal would 
guide them through the payment process, transferring the 
appropriate amount in the appropriate currency from the 
donor's bank account to that of M. Braille's charity.

52 www.adobe.com/products/acrobat/readstep2.html   
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M. Braille used PayPal to create buttons for the Euro, Pound 
Sterling and US Dollar currencies. For each currency he 
created three levels of payment. At the end, PayPal provided 
him with the HTML code for nine payment buttons. He 
copied these codes into NVU under the heading “Donate 
using PayPal”.

The final page that he created, again using NVU, was a 
“Thank you” page. This was the page that PayPal would 
show to donors after they had completed their donation and 
allowed M. Braille to thank the donor in French and in 
English.

For Amazon donations he used Amazon's Honor System 
feature. This required him to have an American bank 
account to receive deposits so he provided the details of a 
sister charity in the USA. At the end of this Amazon 
presented him with HTML code, like PayPal's, that he added 
to his webpage in NVU.

Underneath the Amazon donation button he included the 
501(c)(3) information about the American charity. This 
would allow Americans to count their donation as tax-
deductible.

The beauty of this system was its low cost. Annually, the 
charity had to pay around $100 for the domain name and 
hosting. Furthermore, PayPal and Amazon do not charge any 
setup fees, simply taking around 5% of each donation. Just 
$105 in donations would have made the site self-financing. 
But as it happened, the site became quite profitable, 
attracting interest and donors from around the world, 
including people that the charity's French postal mailings 
had not previously reached.
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Mrs Shrub uses CivicSpace to blog
The 2004 US presidential elections 
demonstrated the use of weblogs by the 
political candidates. Weblogs – or blogs, as 
they're commonly known – are websites in 
which the author can keep a log of events 
and their thoughts about these events.

To a reader a blog is a webpage with several entries. Each 
has a date, a title and some text. The newest entries are at the 
top and the oldest at the bottom.

Readers of blogs like them because they can easily see the 
latest entries – in the US elections candidates placed their 
opinions about the most recent issues and provided links to 
more detailed information. Voters were able to follow these 
to make informed decisions.

Authors of blogs like them because they make writing easy – 
all you would need is a web browser with access to the 
internet. You can access your own blog, log in and fill out a 
new entry. For politicians travelling around the USA this 
was a godsend.

Furthermore, the structure of a blog means that the author 
does not have to worry about the layout, only the writing.

These efforts contributed to Howard Dean's ability to raise 
several million dollars. Ultimately, Dean failed to secure the 
nomination of his party, losing to John Kerry.

However, the software that his team had developed 
continued to be developed even after his campaign ended. 
Now called CivicSpace (www.civicspacelabs.org), it is 
available as Free Software and developers around the world 
have joined the effort to improve its features.
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Mrs Shrub was halfway through her term which meant that 
she would soon begin campaigning again. For now, she had 
enough time to learn to write her blog and for her team to 
begin forging relationships with the authors of other blogs.

Dr Digitalis uses WordPress to create a 
blog about acupuncture

A key advantage of choosing SiteGround for 
web hosting is its Fantastico control panel 
(see Figure 27). It allows you to quickly and 
easily install a whole range of Free 
Software. This includes the WordPress 
blogging software (www.wordpress.org).

Dr Digitalis wanted to write a blog to keep track of 
developments in acupuncture and store links to the articles 
that she found useful. From godaddy.com she bought an 
address ending in .info. In her SiteGround account she 
installed WordPress.

Every day, during her reading of the latest literature, she 
would pick a few articles about which she would write. For 
each she included a link to the article, a few choice quotes 
from its text and her own comment on the article.

This was useful for her memory. First, because she had spent 
this effort on each article she found it easier to remember the 
contents of the article on future occasions. Furthermore, 
WordPress indexes all the entries and provides a search box. 
She could enter into the search box the keywords of the 
article that she was interested in finding and WordPress 
would show a list of the blog entries that included these 
keywords. The more detail she included in each of her 
entries the easier it was to find the article again.
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In time, however, other doctors found the blog useful. Many 
of them were GPs and found the background explanations 
that she gave to be useful and entertaining. They, in turn, 
recommended it to other colleagues. For this kind of 
recommendation it was important that the web address that 
she had chosen was short and memorable.

What Dr Digitalis had not expected was the number of new 
referrals coming her way because of the blog. By providing 
an educational service she was also demonstrating to other 
GPs her knowledge and her ability to explain things clearly 
to patients that the GPs would send. All this without 
advertising.

Mr Big's employees use WordPress 
blogs to keep colleagues informed

More and more businesses are finding the 
advantages of blogs written by employees 
for internal communication. WordPress 
allows the creation of different user accounts 
and different entry categories.

The manager of the San Francisco hotel showed Mr Big the 
employee blogs. Using an internal server, available only to 
employees within the hotel's network, the team had installed 
WordPress.

This meant that each of the senior employees could write 
entries about their own department's work. For each entry 
WordPress would display the name of the author as well as 
its date. The author would also tick the categories to which 
the entry was most appropriate, for example “maintenance”, 
“room service”, “customer feedback” and so on.

This was a great way to communicate amongst the different 
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employees who worked different shifts in different parts of 
the hotel. If an employee wanted to check on the progress of 
a particular item of maintenance they would search the blog.

Some employees found this so useful that they took 
advantage of the RSS feature on WordPress. This would 
allow them to subscribe to the blog in Thunderbird, to 
receive all the entries. At the start of their shift they would 
spend around 15 minutes reading all that had gone on in the 
previous shift.

Mr Big ordered that WordPress be installed on all the 
internal servers of all the hotels. The regional managers 
found they could subscribe to the RSS feeds of all the hotels 
that they were responsible for. The other employees around 
the world took some training before they understood the 
benefits – not all of them were like the technophiles of San 
Francisco.

But soon they too found the act of documentation and the 
ease of searching others' documentation to be useful. In fact 
the pendulum began swinging too much in that direction 
with some managers asking that every employee use the 
blog.

This was possible in the hotels that provided computers and 
internet connections in every room: junior employees that 
worked on individual floors could login to WordPress using 
the computers in customers' rooms and document their 
progress during the day.

However, the problem with this was the information 
overload. Regional managers subscribing to the RSS feeds of 
a hotel's blog were flooded with entries announcing that the 
cleaning of a particular floor's rooms had been completed.

The company's policy became that the main blog was for 
senior employees. Each hotel manager could then choose to 
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have another copy of WordPress for junior employees. This 
would only be of interest to that hotel's employees but 
allowed those employees the freedom to use it in the way 
that suited their work habits.

At any rate the experiment was now enough of a success that 
Mr Big was looking for other solutions that Free Software 
could bring to his web servers. Perhaps San Francisco would 
show the way again.

Further resources
● King Sihanouk's website – www.norodomsihanouk.info 

● Salam Pax's blog – http://dear_raed.blogspot.com/ 

● BoingBoing – www.boingboing.net 

● Free Software for Busy People website – 
www.freedomsoftware.info 

● “Writing for the Web” article by Dr. Jakob Nielsen – 
www.useit.com/papers/webwriting/  

● Dan Briklin's guidelines for web writing – 
www.gooddocuments.com 

● Mohammad Al-Ubaydli's website – www.mo.md 

● “Handheld Computers for Doctors” by Mohammad Al-
Ubaydli. Wiley 2003. ISBN  0470858990 – 
www.handheldsfordoctors.com 

● “Create Your Own Website (Using What You Already 
Know)” by Scott Mitchell. Sams 2004. ISBN 
0672326620.

● HTML tutorial – http://www.w3schools.com/html/ 

● GoDaddy – www.godaddy.com 
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● “Getting an internet address” by Mohammad Al-Ubaydli. 
BMJ Career Focus 2005 330: 130. 
www.mo.md/id174.htm 

● HTML tables tutorial – 
www.w3schools.com/html/html_tables.asp 

● Amazon – www.amazon.com

● PayPal – www.paypal.com

● Civic Space – www.civicspacelabs.org 

● WordPress – www.wordpress.org 
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Amazon is more than a bookshop – it is your bookshop. 
After a few visits to and purchases from the site, it 
begins to include recommendations that are eerily 
attuned to your tastes. But when I visit the site I see 
different recommendations, ones that are tailored to my 
tastes rather than yours. And when your friend visits 
the site they will see recommendations that are also 
unique to them.

This is all possible because Amazon's website is built 
on a database. A database is a place to store data – 
think of it as an electronic filing cabinet. Amazon 
collects all sorts of data about you, including your 
billing address and orders of course, but also your 
rating of these books and even book links you click on. 
It also compares data about you with data about other 
customers and uses that to generate more data.

All of Amazon's pages are shown to you after 
consulting the database. If you are ordering a book 
Amazon shows you previous delivery addresses that 
you used, in case you want to use one of them again. If 
you are looking at a book Amazon shows you ratings 
by other users who have read the book. Most 
lucratively, Amazon constantly extrapolates from your 
previous behaviour to recommend books to you that 
you would not have known about or thought of reading.

You, I and others buy these books because Amazon is 
not in the books business as much as in the database 
business. And databases are the beauty of the web.

The websites that you build with OpenOffice.org and 
NVU will for the most part not be database-driven. It is 
possible and many web programmers do so, to use 
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NVU to develop database-driven sites. But for most people 
the process is complicated and requires too much training.

However, WordPress is a tool that allows the easy creation 
of database-driven sites. To add entries to a blog you need a 
username and a password, which WordPress keeps track of. 
WordPress can keep track of the login details of many users 
and it stores the date and authorship data about each entry.

WordPress is not the only Free Software that allows you to 
create database-driven sites – there are other tools and many 
are far more powerful.

But of course with power comes complexity. These tools 
require time and knowledge to set up and administer but they 
make it easy to create and edit content. So this chapter does 
not provide a tips section to explain how to do everything – 
reading the documentation for every tool is necessary for 
this.

This is why you might find it useful to hire someone's 
services, at least for the setup phase of your site. After that 
you will have the tools and ability to focus on content. So the 
rest of the chapter is to give you ideas on what you might do 
with the tools. Welcome to the database business.
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Examples
Dr Digitalis creates a discussion board (page 110)

Ms Yates uses the Mambo content management system 
(page 113)

Mr Salah Al-Din's students use a Wiki to collaborate in 
writing (page 115)

Mrs Shrub uses CivicSpace for her campaign (page 117)

M. Braille uses Claroline to run courses (page 118)

Mr Big uses dotProject for project management (page 120)

Dr Digitalis creates a discussion board
Bulletin boards, or discussion boards, allow 
the posting and reading of comments about 
different topics. Phpbb (www.  phpbb.com  ) is 
a popular Free Software version.

Dr Digitalis found it under the Discussion 
Boards heading of SiteGround's Fantastico. It took three 
steps to install.

Since starting the blog Dr Digitalis was receiving emails 
from clinicians around the UK and increasingly from abroad, 
asking her questions about acupuncture

The questions were good for business because many were 
followed by the referring of a patient. She also liked 
answering these questions. However, some would always be 
beyond her expertise. Others were simple and frequent, 
requiring her to type the same answers several times in a 
week.

Discussion boards like phpbb make it easy for people to ask 
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questions and others to respond to the questions. It also 
makes it easy to debate the answers.

Furthermore, by debating the answers through phpbb the 
deliberations are available to future visitors to the site. A 
visitor can search through past questions and answers.

Finally, phpbb allows each user to include information about 
themselves. This pleases experts because each can include 
information about their work.

Dr Digitalis recruited colleagues in China, Toronto and 
California to share the load of answering the questions. Their 
geographical spread ensured that there would be at least one 
expert available to answer questions at any time.

Whoever sets up a phpbb site becomes its Administrator. 
This allows controlling the functioning of the site.

For example, at the start Dr Digitalis only allowed registered 
users to see the questions and answers and only allowed 
users to register after she had seen the details on their 
application forms. She wanted to restrict questions to those 
from UK doctors, so she would contact each of the 
applicants to ask for their General Medical Council (GMC) 
number. This would provide a safe environment for 
clinicians to discuss questions amongst themselves and 
maintain patient confidentiality.

However, there were several problems with this stringency. 
First, phpbb is a good system but it is designed for ease of 
use, not security. Quite simply, Dr Digitalis understood that 
she did not understand enough about security to provide the 
site's users with guarantees of confidentiality.

Furthermore, many UK doctors bristled at the registration 
requirement, assuming that Dr Digitalis wanted to send them 
junk mail. And applicants without a UK GMC number 
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would be excluded. This meant that the international experts 
she had recruited would be deprived of local clients and 
patient referrals. In fact the restrictions on reading the 
discussion meant that Google and other search engines could 
not index the site, depriving the experts of a particularly 
significant source of clients: patients searching Google.

Finally, it was simply too much work to look at every single 
applicant's details.

Dr Digitalis switched to a more relaxed approach. She 
allowed anyone to read any of the pages. She also allowed 
anyone to register and to include as few details as they 
wanted to on registration, but registration was still necessary 
to contribute questions or answers. That way search engines 
and casual readers could access the site while a little more 
commitment was necessary to contribute.

Another administrative task is to organise a site's discussion. 
Dr Digitalis created topics and subtopics to help someone 
browsing through the site's past discussions. For example, 
she created the “Consultations” topic for general questions 
about patient problems that could benefit from acupuncture, 
while the “UK”, “China” and “Canada” topics dealt with 
country-specific questions.

The organisation of phpbb also allowed her to devote some 
topic areas to issues that would concern her experts. She 
chose to restrict the access to one area so that only the 
colleagues that she had recruited could read its contents and 
add to them.

This allowed for reasonably confidential discussions 
amongst her team. Most of these discussions centred about 
the occasional registered user who was abusing the forum. 
She would debate with her colleagues how to deal with the 
behaviour. When appropriate, Dr Digitalis could bar that 
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user from using the site and remove any inappropriate 
contributions they had made.

In time she began to entrust her colleagues with more 
responsibility on the site, upgrading their administration 
privileges. This reduced the drain on her time from 
managing the site. It also increased the commitment of her 
colleagues as their profiles showed their new status.

Ms Yates uses the Mambo content 
management system

A Content Management System (CMS) 
allows easy adding to and updating of a 
website's content. Several are available from 
SiteGround's Fantastico including Mambo 
(www.mambosource.com).

Authors like Mambo because its editing 
interface is similar to a word processor's (see Figure 30). 
However, it still runs inside a web browser like Firefox or 
Internet Explorer. This means the authors can do their 
writing on any computer that is connected to the internet. 
You can write while at work, at a friend's computer, or in an 
internet café while on holiday.

Website administrators like Mambo because it is so flexible. 
Someone with a little programming knowledge can change 
every aspect of the website's appearance. There are also 
hundreds of extensions available at www.mamboforge.net. 
These add features to your website like discussion boards, 
group calendars and shopping catalogues.

Ms Yates installed Mambo for her company website. She 
searched Google for “mambo templates” to find ready-made 
designs for the site. She found several available free of 
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charge but paid $20 for a professional design from 
www.templatemuseum.com. Customizing it was far easier 
than creating a template from scratch.

Figure 30: Mambo's content editing has a familiar word 
processing interface but runs inside a web browser

Of course the site lacked content. Ms Yates already had 
several OpenOffice.org documents with the text that she 
needed. She was able to Copy and Paste the text into her 
Mambo pages.

Figure 31: Mambo content is organised in Sections, which in turn 
contain Categories
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She installed mambo-shop53 to manage her shop. This 
allowed her to handle different products, currencies, 
shipping rates, taxes and payment methods. For the latter she 
chose PayPal and WorldPay.

Mr Salah Al-Din's students use a Wiki 
to collaborate in writing

Wikis are websites designed for easy 
collaboration on content. The Wikipedia, at 
www.wikipedia.org, is a great example of 
this tool in action. The site provides free 
access to encyclopaedias in different 
languages. Each encyclopaedia was written 

by hundreds of authors around the world. Each author picks 
a topic about which they have an expertise then they write 
about it.

The twist is the peer review. Anyone can edit any of the 
articles. This sounds like a recipe for chaos but the outcome, 
in this case, is scholarly accuracy: if anyone writes an 
extreme view, other authors with opposing extreme views 
alter the page. This can lead to a back-and-forth of editing 
and counter-editing, but soon the parties settle down on 
objective accuracy, reporting only the facts that cannot be 
disputed and ensuring that all the facts are included.

Mr Salah Al-Din used a wiki to help teach his class about the 
Bahraini Constitution. In 2002 Bahrainis voted 
overwhelmingly in favour of the new Constitution54, based 
on the one that had been suspended in 1975. Mr Salah Al-
Din wanted to help his students understand the document 

53 http://mamboforge.net/projects/mambo-phpshop/   

54www.bahrain.gov.bh/pdfs/constitution.pdf  
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and its political significance.

There are many different types of Wiki software. Mr Salah 
Al-Din chose DokuWiki because its emphasis was on easy 
documentation creation with a clean design 
(http://wiki.splitbrain.org/wiki:dokuwiki). The software has 
its own database as a text file, meaning that installation is 
quick and easy. He uploaded the files to his server, changed 
the access rules for some of the files as described in the 
instructions and the system began working.

Security features were not so good, but this did not matter in 
this case as the DokuWiki would only be reachable by 
computers on the school's network, not by internet users 
outside the network.

He divided his students into teams. Each team would be in 
charge of one part of the constitution. Writing this in a 
DokuWiki is easy. Each student would create a page by 
typing its address in the web browser. For example, to create 
the overview page they would type in 
doku.php?id=overview while to create the page about 
Section 2 Article 3 of the constitution they would type in 
doku.php?id=section2article3. They made sure that the 
overview page listed all the pages in the site and provided 
links to them so that a visitor could browse the constitution.

The next stage was what excited Mr Salah Al-Din the most. 
He asked each of the teams to compare the Bahraini 
Constitution with that of another country. Then the teams 
would write their thoughts in these comparisons. For 
example, the Bahraini Constitution states that Islam is the 
religion of Bahrain, that all citizens are entitled to education 
and healthcare and that the head of state would be a member 
of the royal family chosen through heredity. These features 
were in stark contrast to the US Constitution.
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After each team had written their comparison and 
commentary he asked them to read and edit the efforts of 
every other group. Of course this lead to lively debates 
amongst the students, exactly as Mr Salah Al-Din wanted. 
The school was developing a reputation for teaching civic 
leadership.

Mrs Shrub uses CivicSpace for her 
campaign

Mrs Shrub's campaign team members were 
putting CivicSpace to great use. The 
software's installation is easy and includes 
step-by-step instructions to explain the 
various available options. The team chose to 
use the site as a political action platform 

which would allow them to manage spreading information to 
the voters about the campaign.

Two alternatives are also available.The first, a Slashdot-style 
community site, mimics the features of www.slashdot.org. 
That site, itself a Free Software project, is great for 
discussions between participants but terrible for spreading 
information in the top-down manner that campaigns depend 
on. The second, a personal website or blog, was a possibility 
for Mrs Shrub. However, it lacks the other features that 
would have helped coordinate her campaign.

These include:

• Forum topics to allow discussions amongst voters, 
activists and campaign staff. In the early stages campaign 
staff used these to coordinate their efforts with activists 
and consult them on the messages with which to reach 
out to the voters. In later stages the staff actively invited 
voters to pose their questions and comment on the 
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answers.

• Polls to help quantify opinions. Of course the data is not 
scientific or statistically representative, but visitors to the 
site enjoyed taking part in topical surveys.

• The story feature allows writing lengthy articles.

• The mass mailer streamlines the sending of email 
messages to different groups.

Figure 32: Installation screen for CivicSpace

M. Braille uses Claroline to run 
courses

Apache is the webserver software behind 
most websites and MySQL is open source 
database software that powers an increasing 
number of them. Both have proven their 
stability. 

The latest computer that M. Braille received 
from the GNU/Linux User Group ran Apache and MySQL. 
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M. Braille did not understand how to use these but he did not 
need to – once installed, M. Braille could just add the 
computer to the network in his school and the software 
would just work.

Because the network did not have access to the outside 
internet M. Braille did not have to worry about security – the 
only threat was attack from inside the network and that 
would only come from the school children.

The computer also included Claroline (www.claroline.net), 
which is software for administering an educational 
institution .

When M. Braille logged in to his computer's Claroline site 
he was presented with the view of a course teacher. He could 
create as many courses as he wanted. For each course he 
could write educational material and design exercises and 
tests. He could also determine who had access to each 
course.

Claroline allows the monitoring of which student had gone 
through which educational materials and exercises and their 
scores on the tests. M. Braille could impose time limits for 
the tests and weightings for the questions.

If M. Braille had wanted, he could have run a university 
using this computer. In fact, France's Université de Nantes, 
Britain's University of Glasgow, America's University of 
Pittsburgh and over 350 other organisations from over 55 
countries around the world are using Claroline to deliver 
their education to students.

But his ambitions were more modest. He wanted to provide 
education to more of the parents of students in the village by 
using his limited computer resources. He made five 
computers and one assistant available to the parents of 
students so that they could access his Claroline-powered 
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website.

Thanks to the testing modules he could also provide 
certificates for the parents as they learnt more and completed 
harder tasks. The service was modest but it made a 
difference to the parents and added to their pride. And he 
also knew that educated parents can better support the 
education of their children.

Of course the key was providing useful courses and M. 
Braille greatly enjoyed writing these. But he did not have to 
do all the writing – teaching materials are free at Creative 
Commons (www.creativecommons.org).

The organisation allows creators around the world to make 
their intellectual property available to others according to 
each creator's individual preferences. The education section 
provides lesson plans that are freely available 
(www.creativecommons.org/education) for reuse and 
customisation. In time he would be visiting Creative 
Commons to make his own creations available to others 
(www.creativecommons.org/license/). But for now his 
students would be the beneficiaries of his teaching.

Mr Big uses dotProject for project 
management

Microsoft Project is designed to help with 
managing projects. It can keep track of the 
tasks for the project, the people carrying 
them out and the progress of the project. For 
the latter, the software automatically creates 
Gantt charts55 to provide a visual 

55 Invented by the mechanical engineer Henry Laurence Gantt 
(1861-1919), Gantt charts were used on large construction 
projects like the Hoover Dam, started in 1931 and the interstate 
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representation.

The problem with all versions before Microsoft Project 2003 
is collaboration. Only one person can enter information into 
the file at a time, which usually means that one person 
becomes in charge of entering all the information. That 
person must keep track of all the employees on the project, 
as well as document their progress on all of the tasks.

Microsoft Project 2003 helps solve this problem by 
providing a version that works on a server and a version that 
works on PCs. The server version keeps track of the 
information that the individual employees submit using the 
PC version on their own PCs. However, the server itself 
costs $1,499 and then there is the cost of upgrading to the 
latest PC version.

Mr Big is a fan of Microsoft Project, regularly using the 
older PC version and insisting that his immediate employees 
also use it, but this pricing was too high.

So dotProject (www.dotproject.net) seemed like the perfect 
solution. It is a Free Software project management server 
and its interface is accessible through any web browser.

Once installed each user can create as many projects as they 
need to manage. For each project they can collaborate with 
as many users as necessary. Each user in a project can enter 
information about the tasks they are responsible for, 
including their costs, expected duration and progress so far. 
The person managing the project no longer has to enter this 
information but still gets to see it, including the overview 
provided by Gantt charts that dotProject generates.

DotProject allows storage of files. The team can collaborate 
on these files, amending project proposals in OpenOffice.org 
Writer and presentations in OpenOffice.org Impress. The 

highway network, started in 1956.
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Record Changes feature in OpenOffice.org keeps track of 
these amendments.

The creators of dotProject cared about integration, making 
sure that it worked well with other software. Most 
immediately Mr Big appreciated this because he could 
import his old Microsoft Project files into dotProject. The 
software also integrates into LDAP servers, meaning that Mr 
Big's employees could use the same passwords to log onto 
dotProject as they used to log on to their computers. Once 
logged in they could see the contact details of all their 
colleagues because these had been imported from the 
company's LDAP server. Similar tools are being developed 
to integrate dotProject with the Mambo content management 
system and with the SugarCRM sales force software.

The creators also provided support contracts. The software is 
quite stable and well tested but Mr Big insisted that 
dedicated support be available to his IT department in case 
there were any problems. He began with a US company 
(www.caseysoftware.com) and added a contract with the 
Australian company that had started the whole project 
(www.saki.com.au). A third company, based in Brazil, is 
also available. The time zones meant that the first two 
companies provided his staff with support around the clock.

Further resources
● Phpbb discussion board – www.phpbb.com

● Mambo CMS – www.mamboserver.com 

● MamboForge – www.mamboforge.net 

● Template Museum – www.templatemuseum.com 

● Wikipedia – www.wikipedia.org 
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● DokuWiki – http://wiki.splitbrain.org/wiki:dokuwiki 

● Slashdot – www.slashdot.org 

● Creative Commons – www.creativecommons.org 

● Creative Commons Education – 
www.creativecommons.org/education 

● Creative Commons License – 
www.creativecommons.org/license/ 

● dotProject – www.dotproject.net 

● SugarCRM – www.sugarcrm.com 

● Casey Software – www.caseysoftware.com 

● Saki – www.saki.com.au 
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Part III
Getting serious with Free Software



Finding Free Software to 
suit your needs

According to Barry Schwartz's “The Paradox of 
Choice”, choice can be a bad thing. If that is the case, 
then Free Software is very bad, because so many 
choices are available. It is, as a good friend of mine 
describes it, an embarrassment of riches.

This chapter will help you choose from these riches. It 
will teach you about some of the resources available 
and give some tips for finding and evaluating Free 
Software. The character examples highlight some of the 
best available software to get you started. By the end, I 
hope you will agree that choice is a wonderful thing.

Searching for software – let Google 
guide you
With the right words, you can find most Free Software 
through Google (www.google.com). Google is useful 
because its rankings are influenced by popularity – the 
more websites linked to a particular website, the more 
importance Google assigns to that website. This is 
usually a good indicator of how close software is to 
being the standard in its category.

For example, if you search for web browser, the top 
result on Google is Mozilla, with its open source 
software like Firefox and Thunderbird (see Figure 33).

However, not all examples are this simple. For most 
cases you will need to specify that you are interested in 
Free Software by adding GPL to your search. This 
refers to the GNU General Public License, which has 

http://www.google.com/


Free Software for Busy People

the four freedoms of Free Software. For example, cd rip gpl 
shows Zlurp (www.zlurp.com), which allows you to copy 
your music CDs onto your computer.

Figure 33: Mozilla's Firefox is the top result for web 
browser on Google

You can widen your search a little by using open source 
rather than gpl. Open source software is available free of 
charge and its source code is available for inspection and 
improvement. Free Software is an example of open source 
software, but the term open source is more commonly used 
on Google.

This is why Google shows Audacity as the top result 
(http://audacity.sourceforge.net/) for the search sound editor 
open source.

So far we have used search terms that accurately describe the 
software, but sometimes you will not know the correct 
description. It helps to use the name of a popular commercial 
alternative. For example, word open source shows 
OpenOffice.org on Google.

Finally, you will not always get software as the top result on 
Google. Instead you might more usefully get an article 
guiding you through your options. For example, photoshop 
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open source shows a NewsForge article56 describing 
alternatives to the image editor Adobe Photoshop. These 
include GIMP, which is described in more detail in M. 
Braille’s example on page 135.

Friends, family and forums
Of course, you do not have to accept Google’s judgement of 
the most popular software. Often, choosing the same 
software as the one that your friends and family members are 
using is better. This way you can ask them for help when 
you are learning how to use the software and exchanging 
files is easier. You will also be able to ask for their opinion 
of the software’s strengths and weaknesses.

Finally, contact your local GNU/Linux User Group. 
GNU/Linux is a Free Software operating system, an 
alternative to Microsoft Windows that is discussed in the 
next chapter. Enthusiasts in these user groups provide useful 
advice, training and support with Free Software. Attendance 
at their sessions is almost always free and the details of your 
nearest group will probably be available at 
www.linux.org/groups/.

Downloading the software
Once you find software that you think you will use, you can 
download and install it for your computer. There are three 
points to look out for: the version number of the software, its 
download location and whether or not the file is zipped.

The version number
The version number of the software tells you how recent the 
56 http://www.newsforge.com/article.pl?sid=04/07/19/214206   
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version is. For example, OpenOffice.org 2.0 is more recent 
version than 1.1.4, which is in turn more recent than 1.1.3. 
Usually you will want the latest version because it has the 
most features and the fewest bugs, but there are two 
exceptions.

First, you might want an older version if you have an older 
computer. This is because the fewer features of the older 
version make fewer demands on your computer, which is 
important if the computer is old and therefore less powerful.

Second, the words “beta” or “alpha” next to a version 
number indicate that it is still under testing. This means you 
can get early access to the new features but that the bugs 
have not been fully removed yet. For example, Mozilla 
Firefox 1.1 alpha should only be downloaded by 
programmers because it is so experimental, while Firefox 1.1 
beta is probably stable enough for most users to take 
advantage of the new features. However, if you are using 
your computer for critical work, or if reliability matters to 
you more than features, you should only download Firefox 
1.0 today, or Firefox 1.1 when it is finally available.

Download location
Because Free Software is so popular and because downloads 
make considerable demands on the websites making them 
available, creators of Free Software share the load with 
partners around the world. To download the software you 
must pick one of these partners to get a copy.

For example, OpenOffice.org is available through 
universities (such as Brazil’s Pontifìcia Universidade 
Catòlica do Paranà) and internet service providers (such as 
Australia’s Pacific Internet) around the world. The list is 
shown to you when you click the download link on 
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OpenOffice.org’s website (see Figure 34).

Any of the sites is suitable, but it is often faster to choose the 
one that is closest to you geographically. For example, if you 
are in Canada, choosing the US site will probably be more 
efficient than choosing the Australian one and choosing the 
Canadian one probably the most efficient.

Finally, because you are looking at the page using a web 
browser, make sure that you select the link next to HTTP 
rather than FTP.

Figure 34: you must choose the download site for OpenOffice.org

Unzipping software files
Software installers usually require several files. To save you 
the trouble of downloading each of these separately, 
programmers often combine the files into one. This is the 
case with OpenOffice.org. The combining is called 
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compression, or zipping and you can tell this has been done 
because the file name ends in .zip.

When you download the file you must reverse the 
compression to recreate the original files. This is called 
unzipping.

If your computer is running Windows XP or Mac OS X it is 
already capable of unzipping57. If not, 7-zip is Free Software 
that works on all versions of Windows and allows you to 
unzip (www.7-zip.org).

Incidentally, you can use 7-zip to zip your own files. This is 
useful for emailing several files together as one file; 
converting several large files into one file which is smaller 
than the total of the original file sizes; and for encrypting 
files so that their contents can only be accessed with the 
correct password.

57 http://www.cod.edu/dept/tlc/TIPS/Zip-unzip.htm   
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Examples
Mrs Shrub uses FreeMind for mind maps (see page 131)

Dr Digitalis uses OpenEMR for her patients' medical 
records (see page 133)

M. Braille uses GIMP for drawings (see page 135)

Mr Big uses Gantt Project for project management (see 
page 136)

Ms Yates uses Plucker for her handheld computer (see page 
137)

Mr Salah Al-Din plays games (see page 139)

Mrs Shrub uses FreeMind for mind 
maps

A mind map is a great way to show complex 
information. The most important point is 
largest and at the centre of the page. Its 
subsidiary points appear as smaller branches 
and sub-branches. Using colours and 
pictures provides vivid learning for the brain 

(see Figure 36).

I greatly benefited from this method during medical school 
because it allowed me to understand and remember the 
lectures.

Mind maps (www.mind-map.com) were invented by Tony 
Buzan in the 1960s and since then millions of students, 
businessmen and professionals have benefited from his 
techniques. If you have not read any of his books yet, your 
library will almost certainly contain one and it is well worth 
learning more.
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Figure 35: choosing the download site for the Windows 
version of FreeMind mind mapping software

Mrs Shrub liked to use mind maps because of the number of 
policy reports and data that came to her desk every day. She 
made mind maps of the important reports so that she could 
refer to them later.

Searching for mind maps gpl she found FreeMind 
(http://freemind.sourceforge.net/), which she downloaded 
from the UK’s University of Kent (see Figure 35).Like 
OpenOffice.org, it required the latest version of Java to run 
(http://java.sun.com/j2se/index.jsp).

FreeMind is designed for speed. Pressing the Insert key 
creates a new sub-branch, while pressing the Enter key 
creates a branch of the same thickness (see Figure 36). Mrs 
Shrub could quickly create an outline of the points in any 
document she was reading.

The left hand side contains icons that you can add to each 
branch, or you can add your own pictures and diagrams 
using the Set Image command. Finally, the Export to HTML 
command creates webpages out of mind maps.
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Figure 36: FreeMind creates mind maps

Dr Digitalis uses OpenEMR for her 
patients' medical records

There are several open source tools for 
storing medical records. One of the most 
widely used is the Veterans Health 
Information Systems and Technology 
Architecture (VistA).

Created by and for the US Department of 
Veterans Affairs, the software contains the medical records 
of millions of US military veterans and their families 
(www.worldvista.org). This means it is probably the most 
popular medical records software in the world. Because it is 
available in the public domain it is also used outside the 
USA, including in the Berlin Heart Institute of Germany and 
the National Cancer Institute of Cairo University in Egypt.

However, setting up the software requires considerable 
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expertise and maintaining it requires access to an IT 
department. This meant it was not suitable for the small 
practice of Dr Digitalis.

For her, OpenEMR (www.openemr.net) was more 
appropriate. Its code is available as Free Software and an 
experienced computer professional can install it onto a 
website within one hour.

Once running, OpenEMR is available through any web 
browser software on any computer connected to the internet. 
This included the tablet computer of which Dr Digitalis had 
grown fond.

With the right username and password you can create 
different user accounts for your team members. Through the 
website a clinician can enter information about a patient’s 
problem, examination findings and test results. The clinician 
can also prescribe medications and print off the prescription.

OpenEMR is fully HIPAA-compliant. This means that it 
conforms to the US legislation on the security and portability 
of medical records. Its billing modules work with US health 
insurance clearing houses like ProxyMed and Zirmed.

More importantly for Dr Digitalis, several companies sell 
products and support to ease installation and maintenance. 
For example, for $300 Synitech sells a portable hard disk 
with the software already installed (www.synitech.com). The 
patient records are stored encrypted on the hard disk and this 
can be locked at night. And because it is portable, Dr 
Digitalis could carry it home if she wanted to access her 
patient records there.

In the end, she chose the services of the Pennington Firm 
(www.pennfirm.com). For an annual fee they provide a 
website running OpenEMR through which she could access 
her patients’ records. They make regular backups of the 
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patient data. They also implemented several extra security 
measures such as restricting access to the website so that 
only computers in her clinic or home could view the patient 
records. This meant that Dr Digitalis could stop worrying 
about backups and security and just concentrate on using the 
software to support the care of her patients.

M. Braille uses GIMP for drawings
The GNU Image Manipulation Program 
(GIMP – www.gimp.org) allows you to 
create and edit images. Its features match 
those of Adobe’s Photoshop, including 
layers, masking, blending, toning, image 
maps and scripting.

These features make it well suited to 
professionals, but M. Braille’s students also 
wasted no time in putting it to use.

Because it is such a well established tool, many 
books have been written about it. The GIMP 
website lists these, including the French book 
“(A la) SOS GIMP”58. Its entire text is available 
free online (www.le-radar.com), as is the text of 
the English book “Grokking the GIMP”59.

The site also included several useful tutorials for 
beginners (www.gimp.org/tutorials/). The 
children used these and were soon editing their 
family pictures for the school’s website.

58 “[A la] SOS GIMP” by Cédric Gemy. 2005. ISBN 
2952170312.

59 “Grokking the GIMP” by Carey Bunks. Pearson Education 
2000. ISBN 0735709246.
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Figure 37: 
The GIMP
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In trained hands, the GIMP is a speedy tool because it has 
many keyboard shortcuts. Pressing a series of shortcuts is 
faster than clicking the menu items using the mouse. The 
more experience the students gained, the more they wanted 
to memorise these shortcuts. They were delighted when M. 
Braille bought a copy of “The GIMP Pocket Reference”60.

Mr Big uses Gantt Project for project 
management

Because it is web-based, dotProject does 
have a weakness: entering lots of 
information can be slow.

That is why Mr Big appreciated the ability 
to import Microsoft Project files. At the start 
of a project he could enter lots of 

preliminary details quickly using Microsoft Project then 
import the file into dotProject. Collaborating with the rest of 
the team on finalising the details was faster with dotProject.

Better still, dotProject can import Gantt Project files 
(http://ganttproject.sourceforge.net/). Like Microsoft Project 
this runs on a PC rather than a webserver so it is fast to enter 
data. It matches Microsoft Project for many features.

The software also works with FreeMind thanks to gan2mm 
(http://ganttproject.sourceforge.net/extras.php). This is one 
of the extra tools available and demonstrates an advantage of 
Free Software: because the code and files are transparent it 
easy to create integrated tools.

And because it is free of charge Mr Big insisted that all his 
employees use the software. Combining it with dotProject 

60 “The GIMP Pocket Reference” by Sven Neumann. O'Reilly & 
Associates 2000. ISBN 1565927311. 
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gave the staff powerful tools for planning and tracking their 
projects.

Figure 38: Gantt Project is similar to Microsoft Project

Ms Yates uses Plucker for her 
handheld computer

Plucker can make a copy of a website. This 
is useful if you want to look at the website 
later on without a connection to the internet.

The software comes in two parts: the 
distiller, which makes the copy and the 
viewer, which lets you look at it. The 

distiller is designed to work on a PC running Windows, 
GNU/Linux or Mac OS X operating systems. Although 
viewer versions are available for these PCs the most useful 
versions run on Palm Powered and Pocket PC handheld 
computers.

The Palm Powered version interested Ms Yates the most. 
She downloaded the Plucker Desktop for Windows from 
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www.plkr.org. This includes the distiller for her Windows 
PC and the viewer for her Palm Powered computer. The 
Pocket PC viewer is available at http://vade-
mecum.sourceforge.net/.

Ms Yates used Plucker for news websites. Although 
handheld computer screens are small, the Plucker viewer 
adjusts the layout for comfortable reading. It was perfect for 
long trips. The battery on her handheld computer lasted 
much longer than her laptop’s, allowing her to read the news 
while standing in line or waiting for her flight.

Plucker is also useful for reference websites. For example, 
the entire CIA World Factbook is available for download61 
and Plucker can work on the downloaded webpages. Ms 
Yates loved learning about other countries through this.

Ms Yates also used Plucker to create copies of books from 
Project Gutenberg (www.gutenberg.org). The website has 
copies of books that are available in the public domain. She 
particularly enjoyed reading “Self Help”62, perhaps the first 
book in the self-help genre.

61 www.cia.gov/cia/download.html   

62 “Self Help; Conduct and Perseverance” by Samuel Smiles. It 
was originally published in 1859, the same year as “On 
Liberty” by John Stuart Mill and “On the Origin of Species” by 
Charles Darwin.
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The website www.palmopensource.com contains several 
other Free Software tools for handheld computers. Most of it 
is for Palm Powered devices, but the newer 
http://ppc.palmopensource.com/ contains Pocket PC 
software as well. The sites include several serious business 
applications that helped Ms Yates with her work – but it was 
the game OpenChess that occupied her most 
(http://palmopenchess.sourceforge.net/).

Mr Salah Al-Din plays games
There are many Free Software games 
available, including the educational ones 
like Tux Typing produced by Tux4Kids 
(www.tux4kids.com).

One of the most comprehensive listing is the 
Games / Entertainment category63 of 

www.sourceforge.net. The students used this to find a Free 
Software version of the Risk (http://jrisk.sourceforge.net/) 
board game.

Many of the multiplayer games can be played through a 
computer network. To start a game, one student would 
designate his computer as a game server and the other 
students would use their computers to connect to it. All the 
students connected to the server would be able to play the 
same game together.

Some games, like FreeCiv (www.freeciv.org), make public 
servers available (http://pubserver.freeciv.org/). This allowed 
the students to play from their home computers with their 
friends from around the world. But it was Mr Salah Al-Din 
that played the most. The game is a Free Software version of 
Sid Meier’s classic game, Civilization, which is wonderful 

63 www.sourceforge.net/softwaremap/trove_list.php?form_cat=80   
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for teaching history. As the game progresses the player 
builds cities of increasing sophistication and develops 
technologies and military units.

Finally, there are plenty of Free Software games that offer 
original gameplay rather than copying existing commercial 
games. But many of these are only available for the 
GNU/Linux operating system, with no Microsoft Windows 
version available. The students began asking Mr Salah Al-
Din for copies of GNU/Linux.

Further resources 
● Google – www.google.com 

● Zlurp – www.zlurp.com 

● Audacity – http://audacity.sourceforge.net/ 

● Guide to Adobe Photoshop alternatives – 
http://www.newsforge.com/article.pl?sid=04/07/19/21420
6 

● GNU/Linux User Groups – www.linux.org/groups/ 

● Guide to unzipping on Windows – 
http://www.cod.edu/dept/tlc/TIPS/Zip-unzip.htm 

● 7-zip – www.7-zip.org 

● Mind maps – www.mind-map.com 

● FreeMind – http://freemind.sourceforge.net/ 

● Java – http://java.sun.com/j2se/index.jsp 

● VISTA – www.worldvista.org 

● Synitech – www.synitech.com 

● Pennington Firm – www.pennfirm.com 
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● GIMP – www.gimp.org 

● “[A la] SOS GIMP” by Cédric Gemy. 2005. ISBN 
2952170312.

● “Grokking the GIMP” by Carey Bunks. Pearson 
Education 2000. ISBN 0735709246.

● “The GIMP Pocket Reference” by Sven Neumann. 
O'Reilly & Associates 2000. ISBN 1565927311. 

● GanttProject – http://ganttproject.sourceforge.net/ 

● Gantt Project extras – 
http://ganttproject.sourceforge.net/extras.php 

● Plucker, including distiller for Windows and viewer for 
Palm Powered handheld computers – www.plkr.org 

● Vade Mecum Plucker viewer for Pocket PCs – 
http://vade-mecum.sourceforge.net/ 

● CIA World Factbook – 
http://www.cia.gov/cia/download.html 

● “Self Help; Conduct and Perseverance” by Samuel 
Smiles. Project Gutenberg provides the text at 
http://www.gutenberg.org/etext/935 

● http://palmopenchess.sourceforge.net/   

● Tux4Kids – www.tux4kids.com 

● SourceForge – www.sourceforge.net 

● SourceForge Games / Entertainment – 
www.sourceforge.net/softwaremap/trove_list.php?form_c
at=80 

● Risk – http://jrisk.sourceforge.net/ 

● FreeCiv – www.freeciv.org 
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● FreeCiv public server – http://pubserver.freeciv.org/ 
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Go all the way with 
GNU/Linux operating 

system
On January 6th 2005, Bill Gates's computer crashed, 
again. Embarrassingly this happened while he was 
giving the keynote speech at the International 
Consumer Electronics Show in Las Vegas. Even if Mr 
Gates had been using OpenOffice.org Impress rather 
than Microsoft PowerPoint his presentation would still 
have had an unnecessarily high chance of crashing 
because his computer was running Windows. As you 
read this chapter there may well be another news story 
about a bug or virus that is threatening Windows users.

It does not have to be this way.

GNU/Linux is good
So far most of the Free Software tools in this book run 
on Microsoft's Windows and Apple's Mac OS X 
operating systems. I chose these tools because you can 
experience the advantages of Free Software without 
having to change your habits.

But a Free Software operating system does exist and it 
is called GNU/Linux. In fact it is the jewel in the Free 
Software crown: secure, high quality, tested software 
that enterprises depend on for their most critical 
computing tasks.

All the Free Software described so far is available in 
versions that run on GNU/Linux. There are also some 
great examples that only run on GNU/Linux, with no 
Windows versions available. For example, GnuCash is 
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respected accounting software (www.gnucash.org). Scribus 
has impressive desktop publishing capabilities for designing 
posters, brochures and books (www.scribus.org.uk). 
Evolution (www.gnome.org/projects/evolution/) has the 
features of Microsoft Outlook, including a calendar and 
address book. It also has Microsoft Exchange compatibility, 
without the security risks and viruses of Outlook.

As operating systems go, GNU/Linux is rather efficient. It 
runs quickly even on computers that may be running too 
slowly with Microsoft Windows. Many users begin their 
switch to GNU/Linux by installing it onto an old computer 
that is no longer coping with Windows.

GNU/Linux is also more secure. The Honeynet Project's 
(www.honeynet.org) researchers regularly test operating 
systems for their ability to withstand attacks from the 
internet. Their January 2005 report64 showed that PCs 
running unmodified GNU/Linux lasted an average of three 
months before being hacked. The average time for PCs 
running unmodified Windows was measured in minutes.

GNU/Linux is not for beginners
There are some caveats. Not all the software that is available 
in a Windows version is also available for GNU/Linux. This 
is changing as more software is developed for the expanding 
market of GNU/Linux users. 

You might still find that one or two applications you depend 
on are only available for Windows.

There are two ways around this. The easiest is to find 
alternative software designed for GNU/Linux. For example, 
Evolution has similar features to Microsoft Outlook and its 

64 http://www.honeynet.org/papers/trends/life-linux.pdf   
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interface will be familiar to anyone who is used to Outlook's. 
The software is also compatible with Microsoft Exchange, 
meaning that your GNU/Linux machine fits perfectly well 
into a network of Windows machines.

Alternatively, for specialised applications with no 
GNU/Linux alternative, you can use emulator software. This 
allows your GNU/Linux machine to act like Windows for 
the purposes of running your Windows software. One of the 
most popular emulators is called Wine (www.winehq.com) 
and it is quite usable for most Windows software.

The other caveat is more significant: GNU/Linux works in a 
different way to Windows. On the one hand, this is a good 
thing; it is how you can avoid the crashes and security 
problems of Windows. On the other, this will mean a period 
of unfamiliarity at the start.

In the past few years, one welcome development has been a 
dramatic improvement in the GNU/Linux user interface. 
Newer versions of the software are more user-friendly and 
some versions have tried to mimic the Windows interface, 
making the switch less painful.

But it is not painless. You should only install GNU/Linux 
if you are a computer expert, or if you have the help of a 
computer expert. For a start, the expertise is necessary to 
choose between the different versions.

There are many versions of GNU/Linux
There are different versions of GNU/Linux and the 
differences matter. Each of the versions, known as a 
distribution (www.linux.org/dist/), is maintained by one 
company or organisation. Each distribution focuses on a 
particular group of users. Making the right choice at the start 
will save you effort and ensure your needs are met.
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Examples
Mr Salah Al-Din experiments with Knoppix live CD (page 
146)

Ms Yates chooses Linspire for ease of use (page 147)

M. Braille chooses Ubuntu for its international features 
(page 150)

Mrs Shrub chooses a Beowulf cluster for affordable and 
scalable computing power (page 151)

Dr Digitalis chooses Lycoris for her tablet PC (page 153)

Mr Big chooses Red Hat for support (page 155)

Mr Salah Al-Din experiments with 
Knoppix live CD

A live CD is a safe way of trying 
GNU/Linux. Whenever you start up a 
computer with a live CD inserted the 
computer will run GNU/Linux. No software 
will be installed, instead the operating 
system will run from the CD.

If for any reason you decide you no longer want to use 
GNU/Linux, take out the CD and restart the computer. The 
computer will return to whatever state it was in before you 
used the CD. Your Windows installation and files will be 
untouched.

One of Mr Salah Al-Din's students gave him a live CD 
version of GNU/Linux Knoppix (www.knoppix.org). He 
tried it on an old computer and it ran well. The CD included 
Firefox, OpenOffice.org and other tools for class work.

Rather than installing it, Mr Salah Al-Din decided to make 
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copies of the CD for each of his classroom's computers. This 
way he would avoid the problems of Windows crashing in 
the classroom and of students making changes to the 
computers that he had to fix. All he had to do was restart the 
computer and the live CD would return to its original 
GNU/Linux state, ready for the next classroom.

He also made copies of the CD for other students to take 
home – Knoppix included several games that they had been 
asking for.

Ms Yates chooses Linspire for ease of 
use

Linspire (www.linspire.com) is one of the 
easiest versions of GNU/Linux to use. When 
Ms Yates decided to switch she found it at 
her local Staples store. The Value Bundle 
includes a CD and a one year subscription.

She switched because she could not restart 
her Windows computer. She did not know why and the 
computer support representative did not know why either. 
The representative could only suggest using the recovery CD 
that had come with the computer.

Sadly, “recovery” was a misnomer. The CD would delete all 
the files on her computer and then install a new copy of 
Windows. She would have to install any other software that 
she wanted. And, she would only be able to reclaim her files 
because she had been regularly  backing up her computer, 
making weekly copies of her documents onto external hard 
disks.

Within half an hour of inserting the Linspire CD into her 
laptop computer, Ms Yates was browsing the web through 
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her broadband connection. The software looked as familiar 
and easy to use as Microsoft Windows (see Figure 39).

However, in some ways Linspire was even easier to use. The 
one year membership meant she could take advantage of the 
Click-N-Run (CNR) Warehouse. This gave her access to 
thousands of software applications. She would select the 
ones she wanted to install and CNR would take care of the 
rest.

Figure 39: Linspire has a friendly and familiar user  
interface

Half an hour later, she had installed the latest versions of 
OpenOffice.org, Firefox, Thunderbird and GIMP. She also 
found new software like Evolution, which was more 
powerful than Thunderbird and Gnucash, which seemed 
promising as an alternative to Quasar Accounting. In the 
end, however, she stuck to Quasar because she wanted to use 
her prior accounting files and Thunderbird because she was 
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used to it.

Browsing the CNR Warehouse is particularly useful because 
it is well organised into categories and the software tools in 
each category are ranked by popularity. In this way Ms 
Yates identified many software tools of which she was not 
aware.

These included project management tools like Planner 
(www.imendio.com/projects/planner/) which allowed her do 
draw a Gantt chart for the next phase of her marketing plan. 
But it also included plenty of home and educational software 
that her children would enjoy.

The children would not need her laptop to use the software 
because she could install Linspire on all her home machines. 
Within another hour she had installed Linspire on her family 
desktop PC and used her CNR account on that PC to get 
more software.

That PC still had Windows installed, but Linspire coexisted 
happily with it. In time the children preferred the Linspire 
machine because it included software to manage their digital 
camera's photographs (http://info.linspire.com/lphoto/) and 
to organise the music (http://info.linspire.com/lsongs/) from 
their CD collection.

To protect them on the internet Ms Yates bought a one-year 
susbcription to SurfSafe. This service prevents family 
computers from accessing adult-only websites 
(www.linspire.com/surf_safe_info.php).

In time, Ms Yates would feel safe enough to delete Windows 
from that PC. For now, she felt comfortable with the security 
and stability that Linspire's GNU/Linux technology gave her 
laptop.
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M. Braille chooses Ubuntu for its 
international features

Ubuntu has excellent support for different 
languages, particularly African ones such as 
Swahili. This is a language supported by 
OpenOffice.org but not Microsoft Office.

M. Braille first heard about Ubuntu 
GNU/Linux while on a trip to Kenya, where 

another school there was already using it.

Ubuntu GNU/Linux solved another problem that M. Braille 
was facing: donated PCs with Microsoft Windows 98. 
Because Microsoft had stopped supporting Windows 98, he 
could not get security updates to ensure the safety of the 
machines when browsing the internet. Ubuntu can run on 
these machines and includes excellent security.

Installing Ubuntu (www.ubuntulinux.org) is easy. M. Braille 
copied an installation CD from the Kenyan school and 
inserted it into each of his PCs. The Ubuntu website also 
provides free CDs and covers the costs of delivery 
(http://shipit.ubuntulinux.org/).

The CD automatically detected the different hardware and 
configured it to access the network. It also installed several 
common software packages including OpenOffice.org, 
Firefox, Evolution and GIMP – everything a school PC 
needs.

The students liked the interface because it was colourful and 
simple to use (see Figure 38). M. Braille liked it because it 
placed strict limits on what changes the students could make 
to the settings.

M. Braille decided to use Ubuntu even on PCs that came 
with later versions of Windows.
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Figure 40: Ubuntu is perfect for schools

Mrs Shrub chooses a Beowulf cluster 
for affordable and scalable computing 
power

Mrs Shrub instructed her computer officer to 
lay out a plan for switching to GNU/Linux. 
The easiest starting point, he decided, was to 
switch the government's web servers to 
GNU/Linux.

The machines were currently running 
Windows as the operating system, MySQL as the database 
and PHP as the programming language. The same machines 
could have GNU/Linux installed on them, then use the same 
PHP code and MySQL database to serve the public.

But the new machines would function better because the 
team chose a Beowulf cluster (www.beowulf.org). This is 
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the method used by Google and other organisations running 
websites with enormous demand because it allows affordable 
upgrading of computer resources to meet demand.

For example, when a citizen visits the London government 
website to pay off a parking ticket, he or she is assigned the 
least busy computer within the Beowulf cluster. The 
remainder of the citizen's visit is handled by that computer, 
from the explanations of the process of payment to checking 
with the citizen's credit card provider for availability of 
funds.

If any computer in the cluster breaks down, the cluster 
continues to work – albeit a little more slowly – with the 
remaining computers. When the failing computer is replaced, 
the cluster returns to its former speed.

The power of the system is that it has almost no diminishing 
returns. In other words, doubling the number of computers 
working in the cluster doubles the power of the cluster. It 
can handle twice as many visits by citizens, or handle the 
same number of visits in half the time.

By switching from Windows to GNU/Linux the computer 
team was able to switch their efforts from plugging the 
security holes and breaches of their servers, to improving 
their power and responsiveness to citizens' demands. The 
results for citizens were measurable and Mrs Shrub made 
sure that the measurements were publicised in time for the 
election.

However, the Beowolf version of GNU/Linux is not much 
use for government employees doing their daily work. It 
lacks the user-friendliness of Windows. In fact it lacks 
windows or any other familiar aspects of user interfaces that 
we take for granted today.

For those users, Mrs Shrub's team chose SuSE GNU/Linux 
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(www.novell.com/linux/suse/). They found a London-based 
company that would provide help with the migration from 
Windows to GNU/Linux. It could also provide ongoing 
technical support. The SuSE distribution includes a user 
interface that is similar to Windows.

The switch would be more difficult than switching the 
servers to Beowolf or switching the employees to using 
OpenOffice.org. But again the computers would be faster, 
safer and more stable.

Dr Digitalis chooses Lycoris for her 
tablet PC

A tablet PC looks like a laptop but its screen 
can be turned and folded back onto the 
keyboard. The screen is also touch-sensitive. 
This design has been heavily marketed to 
clinicians. It promised the advantages of 
paper pads.

In reality, tablet PCs running Windows have several 
problems. First, their handwriting recognition is lacklustre 
and slow (particularly with the famously messy handwriting 
of doctors, but that is another matter). The battery life is also 
poor, not enough to last a full clinical day. Furthermore, the 
screen only responds to a special stylus, certainly not a 
finger or a pen.

When Dr Digitalis picked a tablet PC that ran GNU/Linux, 
she did so to avoid that last problem – she was able to write 
on her machine using whatever pointed object was available, 
be it the included stylus or even her finger. She particularly 
favoured TrueTip pen tops (www.truetip.com) because one 
end is a pen tip for writing on paper and the other is a plastic 
tip that worked on her tablet PC.
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The handwriting recognition was not brilliant, but at least it 
used the same alphabet as the one on her Palm Powered 
handheld computer, so she did not have to learn a new 
writing system.

Dr Digitalis and her patients loved the machine. At the 
beginning of each session with a patient, she would use the 
machine as a laptop. She could twist the screen to allow the 
patient to see some details that would be useful to them, like 
the response of their blood pressure to the new hypertension 
tablet. The end of the session would usually involve 
educating the patient, at which point she would switch to 
tablet mode. She used Firefox to show websites that the 
patient would find useful and Adobe Reader to read through 
educational documents before printing them off.

Printing and browsing were easy with the tablet because they 
mainly required tapping the icons on the screen. But 
prescriptions were also possible (and impressive to her 
patients) because they required only limited writing. Instead, 
most of the prescription involved selecting from different 
choices, such as the number of tablets per day or the number 
of days per prescription.

The tablet included Lycoris GNU/Linux (www.lycoris.com). 
This has tablet-friendly features such as switching between 
landscape display (for laptop mode) and portrait display (for 
tablet mode).

But it also shares two features with Linspire. First, its 
interface was reassuringly familiar to users of Windows and 
had similar ease of use. Second, it had the application 
installation features of Linspire, which allowed Dr Digitalis 
to browse easily for and install additional software. The mix 
and focus of the applications was less for the home user than 
the office professional, which suited the needs of Dr 
Digitalis.
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Not that Dr Digitalis did not use the tablet at home. The 
machine included wireless internet connectivity, which is 
what allowed Dr Digitalis to move freely with it from room 
to room in the clinic. Once she got used to browsing the 
internet in tablet mode, however, she could not resist using it 
in the same way at home. She could lie on the couch, glass 
of wine in one hand and TrueTip stylus in the other, reading 
the Guardian newspaper's site in portrait display. It was the 
perfect end to her day.

Mr Big switches to Red Hat for support
At the start of 2005 Microsoft announced 
that they would no longer support Windows 
NT 4. This meant that the company would 
not create any new security fixes for the 
software. Although the NT series of 
Windows was designed for security and was 

the basis of Windows XP's enhanced security, new security 
holes were found every week even in Windows XP. Without 
the fixes, the old NT 4.0 machines would become a greater 
risk every day as new problems were publicly announced but 
solutions remained unavailable.

The business opportunity of legacy NT 4.0 machines was not 
lost on GNU/Linux companies, many of whom bought 
advertising spots where CEOs like Mr Big would see them.

Around the world, many of Mr Big's hotel staff were still 
using machines that ran Windows NT 4.0 software. The 
machines were old, but they worked and replacing them 
would cost too much money.

One of the best companies doing this is Red Hat 
(www.redhat.com). Its Red Hat GNU/Linux distribution had 
become one of the most popular because of its focus on 
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making the switch between Windows and GNU/Linux as 
easy as possible – its installation software was clear and 
comforting, guiding the user through the steps and it 
installed software that Windows users found reassuringly 
familiar.

Now called Red Hat Fedora GNU/Linux, it is still available 
free of charge (http://fedora.redhat.com/). Books like “Red 
Hat Fedora 4: Unleashed”65 include the software on a DVD 
and you can install it onto as many computers as you want.

More recently, Red Hat began focusing all its efforts on 
selling to large organisations, releasing Red Hat Enterprise 
GNU/Linux. For example, it created tools which would ease 
the installation onto multiple machines and assist the 
management of all these machines. Furthermore, its pricing 
and support contracts were scalable, allowing Mr Big's 
company to begin with the Windows NT machines and then 
ramp up their GNU/Linux installations to all of the 
company's computers. Mr Big's Chief Technology Officer 
liked this because it would allow him to “start low and go 
slow”, his favourite aphorism, and thus reduce the risk and 
pain of the switch. And Mr Big himself liked it because the 
costs were transparent, predictable and manageable. He 
could see where the money was going and what his company 
would get out of it.

In time, he would switch all the company's machines to 
GNU/Linux.

Further resources 
● GnuCash – www.gnucash.org 

65 “Red Hat Fedora 4 Unleashed” by Paul Hudson, Andrew 
Hudson, Bill Ball, Hoyt Duff. Sams 2005. ISBN 0672327929.
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● Scribus – www.scribus.org.uk 

● Evolution – www.gnome.org/projects/evolution 

● Honeynet Project – www.honeynet.org 

● Honeynet Project report on GNU/Linux security – 
http://www.honeynet.org/papers/trends/life-linux.pdf 

● Wine – www.winehq.com 

● GNU/Linux distributions – www.linux.org/dist/ 

● Knoppix – www.knoppix.org 

● Linspire GNU/Linux – www.linspire.com 

● Planner – www.imendio.com/projects/planner/ 

● Lphoto – http://info.linspire.com/lphoto/ 

● Lsongs – http://info.linspire.com/lsongs/ 

● SurfSafe – www.linspire.com/surf_safe_info.php 

● Ubuntu GNU/Linux – www.ubuntulinux.org 

● Ubuntu free CDs – http://shipit.ubuntulinux.org/ 

● Beowulf cluster – www.beowulf.org 

● SuSE GNU/Linux – www.novell.com/linux/suse/ 

● TrueTip – www.truetip.com 

● Lycoris GNU/Linux – www.lycoris.com 

● Red Hat GNU/Linux – www.redhat.com 

● Red Hat Fedora GNU/Linux – http://fedora.redhat.com/ 

● “Red Hat Fedora 4 Unleashed” by Paul Hudson, Andrew 
Hudson, Bill Ball, Hoyt Duff. Sams 2005. ISBN 
0672327929.
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How on earth can Free 
Software even exist?

“What is a cynic? A man who knows the price of 
everything and the value of nothing” Oscar Wilde, 
Lady Windermere's Fan (1892) Act 3.

During my childhood I learnt the value of freedom. I 
lived in several countries as my parents travelled to 
pursue their work and studies. These included Syria, a 
communist dictatorship, and Lebanon, a country that 
had been a free-market democracy before its tragic civil 
war.

Back then communism made sense to many people – 
the government would take responsibility for 
organising the economy to produce the goods that its 
citizens needed.

By contrast free markets seemed chaotic. How could 
the right goods be produced if there was no one to plan 
or take responsibility for their production?

But the fact is that they are produced, the system does 
work and it does so better than the central planning of 
communist countries. Understanding this helps us 
understand why Free Software is so important and 
successful.

Free markets and Free Software
What I learnt on my travels is the benefit that freedom 
brings to society.

In a free market, anyone has the freedom to try their 
hand at meeting customers' needs. With time, 
customers find that some companies are better than 
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others for meeting these needs and so they focus their 
spending on those companies.

However, if one of the companies raises its prices or lowers 
the quality of its products, customers are able to redirect 
their spending to that company's competitors. This freedom 
means companies that mistreat their customers go bankrupt 
while those that treat them well grow richer.

More importantly, knowledge of this freedom means that 
companies understand that they must treat their customers 
well. Most companies in free market societies are constantly 
striving to deliver better products at lower prices for their 
customers.

This is particularly clear in the information technology 
industry – every 18 months, for over 40 years, the market’s 
freedom has produced a doubling of computer power, with 
astonishing drops in costs. This phenomenon was described 
in a seminal paper66 by Intel’s Dr Gordon Moore back in 
1965 and led to his eponymous law.

Computing power has been mirrored by software with rising 
features and dropping costs. Wherever there has been 
competition in IT, the customer has benefited. Conversely, 
wherever competition was lacking, the customer has 
suffered.

Free Software ensures competition – any developer is free to 
build on existing Free Software and extend its functionality. 
If this work does improve the software, anyone can benefit 
from the improvements by copying and using the extended 
software. Competition to make these improvements is fierce 

66 “Cramming more components into integrated circuits”, Gordon 
E Moore. Electronics, Volume 38, Number 8, April 19th 1965. 
The original paper is available from Intel: 
ftp://download.intel.com/research/silicon/moorespaper.pdf 
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and as this book has described, the result has been an 
extraordinary variety of quality software.

Free speech and Free Software
My parents spent many years campaigning for the 
democratic rights of their fellow citizens in Bahrain. My 
generation is the first to benefit and in 2002 I was able to 
vote for the first time in my life. My generation is also a 
beneficiary of free speech, an essential right enshrined in 
numerous democracies' constitutions.

Free speech allows honest intelligent discussion of problems 
and their solutions. Without it, accountability collapses and 
corruption begins.

Free Software is built on such openness. The source code 
from which software programs are created is openly 
available for anyone to read and critique. This is why Free 
Software is often referred to as open source software. It is 
also why bugs in Free Software are spotted and fixed more 
quickly than in its closed source alternative.

For example, a study by Stanford University scientists that 
analysed GNU/Linux operating system's kernel source code 
found just 985 bugs in 5.7 million lines of code67. That is just 
0.17 bugs per 1,000 lines of code. Another study, of 
MySQL, found similarly low levels of bugs68. By contrast, 
the industry average for closed code is 20 to 30 bugs for 
every 1,000 lines.

This could explain why bugs are found so often in Windows 
XP's 40 million lines of closed source code.

67 www.wired.com/news/linux/0,1411,66022,00.html   

68 www.internetnews.com/security/article.php/3469631   
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The principle extends to security. Bruce Schneier 
(www.schneier.com) is the celebrated author of several 
textbooks on security and the co-founder of Counterpane 
Internet Security, Inc. His book “Beyond Fear”69 is well 
worth the read and discusses openness versus secrecy for 
security.

The secrecy of closed source software is bad for security. As 
Schneier explains the computer security world has long ago 
“learned that publishing security vulnerabilities is the only 
way to get software vendors to fix them. Before publication 
was the norm, vendors would routinely deny the existence of 
vulnerabilities and not bother fixing them... The risk, of 
course, is that attackers learn about the vulnerabilities and 
exploit them.”

In fact secrecy creates dangerous ignorance for the user. 
Taking the example of door locks described in his book there 
was “a vulnerability in a certain type of door lock that has 
existed for a hundred years or so”. Locksmiths and criminals 
knew about the vulnerability, but most customers did not and 
continued to buy the faulty locks.

Furthermore, the ignorance of users of closed software 
means that they will not demand better software. Finally, of 
course, secrecy in the name of security can be misused to 
hide the mistakes and malpractice of companies.

For all these reasons democratic societies benefit from 
openness and Free Software benefits from open source 
practices.

This explains why so many government and commercial 
security agencies have recommended against using the 
closed source Internet Explorer and in favour of the open 

69 Pages 130-132 of “Beyond Fear” by Bruce Schneier. Springer 
2003. ISBN 0387026207.
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source Firefox70.

Freedom isn't free
Just because Free Software is available free of charge to 
users and distributors, it does not mean that it cost nothing to 
create. Quite the contrary – it is the result of the labours of 
tens of thousands of software developers around the world 
requiring astonishing investments of time, effort and 
knowledge.

Such investments requires payment and the only reason they 
continue, and indeed increase, is that the payments continue 
and increase. There are several ways in which this happens.

1 – Programmers are funded by their 
institutions
The beginnings of Free Software rest with Richard Stallman 
(www.stallman.org), who created the GPL license and the 
Free Software Foundation (www.gnu.org).

He wrote software to solve a problem as part of his work for 
his employer. Working at MIT's Artificial Intelligence 
Laboratory in the 1970s he and colleagues used a printer that 
frequently broke down. However, because his team had the 
source code for the software connecting the printer to the 
computer they were able to write additional software that 
alerted them whenever the printer had broken down. This 
saved a lot of time for MIT's employees so was worth the 
initial investment in writing the software.

Around the world thousands of software developers are paid 

70 For example, see www.washingtonpost.com/wp-
dyn/articles/A5524-2004Jun25.html and 
www.theregister.co.uk/2004/09/13/german_ie_jitters/ 
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by their employers to fix bugs and add features to Free 
Software programs. Such investments are good for the 
employers because their immediate business problems are 
solved, but also good for the rest of us as the GPL license 
means that the solution has to be shared with other users.

2 – Software companies reduce their costs by 
sharing development with the Free Software 
community
Other companies save money on development costs by 
making their software available through the GPL license. For 
example, in 1999 America Online bought Netscape for 
around $4 billion. Netscape made web browser software and 
AOL wanted to have an alternative to Microsoft's Internet 
Explorer. By creating the Mozilla Foundation and giving it 
the source code for Netscape's browser products AOL was 
able to ensure the continued development of the software for 
a relatively small investment of $2 million over the first two 
years. Mozilla was then able to receive investments from 
Red Hat and Sun as well as the development efforts of 
software developers around the world.

The result has been the continued development of the 
Mozilla suite, as well as the creation of Firefox, Thunderbird 
and other software projects. AOL can now incorporate 
Mozilla's browser technology into its own products as a valid 
and highly cost-effective alternative to Internet Explorer.

Sun itself makes money from Free Software by providing 
technical support services. In 1999 it bought the StarOffice 
software company and then made the source code freely 
available in the form of OpenOffice.org. By making the 
source code available to the community Sun was also able to 
ensure continued high quality development of the software 
for a minimal investment of its own resources. On this 
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foundation it built and sold StarOffice which is essentially 
the OpenOffice.org suite with clipart libraries and technical 
support.

3 – Companies earn money from services
Companies like IBM make money by providing consulting 
and integration services. In the 1990s the company made a 
commitment to GNU/Linux as the operating system it would 
recommend to its clients because this would provide the 
value and power demanded by its corporate customers. 
These clients pay IBM to incorporate Free Software 
solutions into their computer networks and buy IBM 
hardware running this software. The transformation to this 
business model was described by its CEO Louis V. Gerstner 
in his surprisingly enjoyable book “Who Says Elephants 
Can't Dance?”71 and he credits it with billions of dollars in 
revenue streams for the company.

RedHat, another investor in the Mozilla Foundation, is one 
of the companies that makes money from distributing Free 
Software, mainly the GNU/Linux operating system. It 
focuses its efforts on large organisations, ensuring that 
system administrators can deploy GNU/Linux software as 
fast and securely as possible. By contrast, Linspire focuses 
on consumers, providing them with a version of GNU/Linux 
that is easy to use. Clients also pay a yearly subscription to 
have easy access to thousands of software applications 
which they can install through the internet.

71 “Who Says Elephants Can't Dance? Inside IBM's Historic 
Turnaround” by Louis V. Gerstner, Jr. HarperBusiness 2002. 
ISBN 0060523794.
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4 – Companies earn money from software 
development
Of course software development itself can be profitable. The 
most popular open source database, MYSQL 
(www.mysql.com), is made by a Swedish start-up of the 
same name. The software is freely available through the 
GPL license but the company makes its money from 
customers who want to be able to customise the software 
without making those customisations available to others. The 
company's clients include the Associated Press, Google, 
NASA, Sabre Holdings and Suzuki.

Many such Free Software start-ups are arising around the 
world. For example, Pennington Firm makes the OpenEMR 
(www.openemr.net) medical records software and sells 
installation and technical support. Octance Security 
(www.octane-security.com) extends existing Free Software 
like MailScanner (www.mailscanner.info) and SpamAssasin 
(http://spamassassin.apache.org) which it sells as security 
solutions.

The best of these companies will increase revenues and 
profits and their size may come to rival that of software 
giants like Microsoft, Oracle and Adobe.

5 – Money is not always necessary
It is worth pointing out the non-monetary methods of 
compensation. For many programmers, contributing to Free 
Software projects is a labour of love. The only payment that 
they ask for is attribution as they take pride in their name 
being attached to great software. Others use it as a way of 
building their skills and expertise. They can then use these 
for future employment and higher salaries.

165

http://spamassassin.apache.org/
http://www.mailscanner.info/
http://www.octane-security.com/
http://www.openemr.net/
http://www.mysql.com/


Free Software for Busy People

6 – Governments support Free Software for 
national security
Governments have their own agendas on behalf of their 
citizens. For example, in the name of national security, the 
governments of China, South Korea and Japan announced 
that they would develop Asian GNU/Linux. This version of 
the GNU/Linux operating system would assuage concerns 
over the use of the Microsoft Windows operating system 
because the source would be open and transparent. Critical 
government computing infrastructure would not be in the 
hands of a single American software company.

Also in the interests of transparency the government of 
Brazil is considering developing Free Software in its 
electronic voting machines. Britain's taxpayer-funded BBC 
created Dirac video compression software to facilitate its 
public service mission of making its programmes freely 
available to the public. In the USA, funding for the 
government's National Institutes of Health (NIH) now 
includes the development of open source software to support 
biomedical research.

There are plenty of other reasons that investments in Free 
Software are made, but the result is the same: we all benefit 
from the advancement and availability of these tools.

Further resources 
● “Cramming more components into integrated circuits”, 

Gordon E Moore. Electronics, Volume 38, Number 8, 
April 19, 1965. 
ftp://download.intel.com/research/silicon/moorespaper.pd
f 

● “Beyond Fear” by Bruce Schneier. Springer 2003. ISBN 
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0387026207.

● Bruce Schneier – www.schneier.com 

● Richard Stallman – www.stallman.org 

● Free Software Foundation – www.gnu.org 

● “Who Says Elephants Can't Dance? Inside IBM's Historic 
Turnaround” by Louis V. Gerstner, Jr. HarperBusiness 
2002. ISBN 0060523794.

● MySQL – www.mysql.com 

● OpenEMR – www.openemr.net 

● Octane Security – www.octane-security.com 

● MailScanner – www.mailscanner.info 

● SpamAssasin – http://spamassassin.apache.org 
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Giving back to the Free 
Software community

“The general tendency of monopolies is to make things 
dear, to make them scarce, and to make them bad.” — 
Thomas Babington Macaulay72

I wrote this book for two reasons. First, because I take 
great pleasure and pride in teaching others how to 
benefit from technology. In writing “Handheld 
Computers for Doctors” I was able to teach clinicians 
how to make use of an affordable technology – 
handheld computers – to improve patient care. With 
this book I am able to teach an even wider audience 
about an even more affordable technology.

This chapter is about the second reason for writing this 
book. I want to explain to you why you should care 
about the health and development of the Free Software 
movement.

Yes, for many around the world, it is a movement. It is 
one with similar moral imperatives to movements to 
improve the environment, tackle poverty and uphold 
civil liberties. And it is one with political dimensions 
and challenges.

I hope that the previous chapters have convinced you of 
how much you can benefit from Free Software. The 
rest of this chapter will explain what you can do in 
return.

Ask what you can do
Of course, the method of helping that is easiest to 

72 http://www.law.duke.edu/boylesite/experiment.html   
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understand is giving money. Almost all Free Software sites 
accept donations and they use this money to invest in further 
development of the software. For many volunteers working 
on such projects the donations act as reassurance that their 
work is appreciated and motivation to work even more.

So the next time that you particularly appreciate the quality 
of some Free Software, consider donating. If you work for a 
business that uses Free Software talk to your boss about 
making a donation from the company's budget. Your 
company will have already saved great sums by switching to 
Free Software and faster development and improvement of 
this software will make a measurable contribution to your 
company's profit margins.

Many of these donations are tax-deductible. For example, 
the Mozilla Foundation (www.mozilla.org), the Open Source 
Applications Foundation (www.osafoundation.org) and the 
Free Software Foundation (www.gnu.org) are all section 
501(c)3 compliant which means that donations can be 
deducted from US tax payments. Analogous deductions are 
possible for other countries' tax systems as well.

But money is not the only contribution, nor necessarily the 
most important.

1 – Give feedback
For example, you have an important contribution to make 
simply by reporting problems in the software. Some groups, 
such as the Mozilla Foundation, make this particularly easy 
for you by including the Quality Feedback Agent73 (QFA). 
The QFA appears when the software crashes and asks you to 
fill out a report of what you were doing when it happened. 
This report is sent back to the developers who can then 

73 www.mozilla.org/quality/qfa.html   
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include fixing this bug in their development schedule.

Using the QFA takes little of your time but provides 
valuable data to the software developers. Through receiving 
thousands of reports from around the world they can quickly 
identify new bugs. They can also assess the impact of a bug 
from the number of reports they receive about it. We all 
benefit as the developers are rapidly alerted and can focus 
their efforts on the most important bugs.

2 – Teach in your community
One thing we can all do is teach. In my case I felt so strongly 
about this that I wrote a whole book, but all kinds of 
teaching are necessary. If you have a website, write articles 
about the software that you find useful. In fact, just by 
posting a link to the websites of Free Software projects you 
help people looking for the software. This is because search 
engines like Google constantly analyse the links. The more 
links that a site receives the more importance it assigns to 
that site and the more frequently it displays the site to 
searchers.

Consider writing a letter to your newspaper, an article in 
your journal or a tutorial for your school newsletter.

For many people the decisions that they make about 
computer technology are determined by the advice of their 
friends and colleagues. The biggest barrier to adopting Free 
Software is often the uncertainty that comes with novelty. 
You can reassure them because you use and benefit from the 
software and you can educate them about properties of Free 
Software that deliver quality with value.

When your friends do decide to make the switch they will 
need a little support to get them going. Consider installing 
the software onto their machine and spending the first hour 
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with them. You can show them how to do the things with the 
new software that they were used to doing with the old 
software. And you can show them how to do new things of 
which they had not even thought.

3 – Teach your boss
If you work for an organisation, convince the decision 
makers to make the switch. Going through this exercise will 
do wonders for your career. First, you will have to write a 
formal proposal making a strong business case for the 
switch. This is a useful exercise and good expertise to 
mention on your CV. It is also an opportunity to come to the 
attention of your organisation's leaders. Try to send your 
proposal to the highest level of management in your 
organisation because this is a strategic switch that requires 
their attention. Once this works you will become associated 
with a successful project that saved money and improved 
quality.

Then of course there is the biggest organisation of them all – 
your government.

Ask what your country can do
Governments have an important role to play in Free 
Software. First, there is the financial support they give Free 
Software projects. Second, governments can insist on open 
standards for storing the important data for which they are 
responsible. Finally, they must avoid passing harmful laws.

1 – Governments can fund Free Software
When the local governments of Paris, Munich and Haarlem 
in Europe made the switch they saved money without 
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sacrificing quality. As taxpayers we should all care about 
such trends and ensure that they continue.

Make sure your local government representative knows that 
you expect them to consider Free Software as a way to spend 
your money intelligently. At local town hall meetings you 
can teach the audience about the benefits of this software.

2 – Governments can demand open data 
standards
A bigger role comes from the government's ability to set 
standards. Take the example of data standards. Even with 
expensive commercial software and top specification 
hardware the most expensive component of computing is 
data. The salary for the hours that you may spend creating 
Microsoft Word documents is far more than the cost of 
Microsoft Word itself. For every organisation data is far 
more expensive than the computers on which it resides or the 
software used to manage it.

Given this importance, open data standards are crucial. Most 
proprietary software tools use proprietary data formats. This 
means that only the company which wrote the software truly 
understands the data format and in many cases the company 
takes significant efforts to obscure the details of the format. 
Proprietary software business models depend on this, 
guarding data format as a commercial secret, because it 
locks their customers into depending on the software 
company for the safety of their data.

Only the software company benefits from this. The 
customers do not, starting with the high costs that the 
company can charge because customers are dependent on the 
company for the safety of their data.

Furthermore, if the company were to go bankrupt, or simply 
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decide that supporting the software is no longer worth the 
investment, the customers are left in a terrible position. The 
data that they depend on is only accessible through software 
that will neither improve in features nor decrease in bugs. 
And because the format is proprietary it may prove 
impossible to transfer the data into another format for use 
with other software.

Because governments keep track of crucial data, they must 
ensure that the formats they use are open. This is one of the 
reasons why the Department of Veterans Affairs (VA) in the 
USA chose the open source method for its electronic medical 
records software. The Department is responsible for the 
healthcare of 26 million veterans as well another 44 million 
Americans who are the families and surviving dependants of 
veterans.

Dealing with so much important data means that the VA 
could not afford the risk of using proprietary formats. In fact, 
the history of medical software is littered with failed 
software projects74 and the subsequent failure of the 
companies that owned the software. So the VA decided to 
develop the software itself, openly and over time, to reduce 
the risks and ensure delivery of the exact features that it 
needed. Because it is funded by US taxpayers the software 
that it created is made freely available in the public domain 
for anyone to use.

The project began in the 1980s as Decentralized Hospital 
Computer Program (DHCP) and was launched as the 
Veterans Health Information Systems and Technology 
Architecture (VistA – www.worldvista.org) in 1996. Over 
20 years the software has proved its stability and quality. 
Because it is available free of charge, users around the world 
are deploying it. And the open data format means that data 

74 http://www.pubmedcentral.gov/articlerender.fcgi?artid=129665   
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can be exchanged between different healthcare providers.

This makes it a solution to a problem that plagues the US 
healthcare system and those of other countries around the 
world. The proprietary data formats in use in each practice, 
laboratory and hospital around the country are incompatible. 
Each year these healthcare providers spend millions trying to 
convert data from one proprietary format to another as they 
try to share data about patients under their care. Often they 
end up with the lowest common denominator – printing out 
tons of paper in medical records which recipients must then 
type into their own medical records software.

This is why the software is under consideration as the 
building block of President Bush's plan for a nationwide 
electronic health record system.

In the Netherlands the government has taken the principle of 
open data formats even further. In 2002 the  Dutch Lower 
Chamber unanimously carried a motion requiring that by 
2006 all government IT purchases would be of software that 
was based on open standards.

Not only do such purchases ensure that government data is 
safe, they also allow Free Software to compete on a fair 
footing in the marketplace. One of the biggest barriers to 
adoption of OpenOffice.org was that most businesses had 
been locked into using Microsoft Office. The creators of 
OpenOffice.org overcame the technical barrier by ensuring 
that their software was compatible with Microsoft's 
proprietary file format. However, government laws and 
purchases that are friendly to Free Software overcome the 
psychological barrier and have spurred the virtuous cycle of 
OpenOffice.org's adoption around the world.
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3 – Governments should avoid passing bad 
laws
The final and perhaps most important role of government is 
that of doing no harm. For example, one of the most harmful 
laws adopted in USA is that for software patents. In 1996 the 
US Patent and Trademark Office adopted its Final Computer 
Related Examination Guidelines. These allowed the 
patenting of software processes.

It is important to realise that before 1996 the software 
industry was making tremendous strides in innovation and 
software companies were investing millions of dollars in 
development. In other words, laws to allow software patents 
have never been necessary to support software innovation 
and investment.

Lawrence Lessig is Professor of Law at Stanford University 
(www.lessig.org) and author of several books, including 
“Free Culture”75 (www.free-culture.cc). This book describes 
the harm that software patents will cause to the software 
industry's development. In fact on page 140 he includes a 
memo written in 1991 by Bill Gates, chairman of Microsoft, 
criticising software patents because “established companies 
have an interest in excluding future competitors”. Software 
patent laws give them the tools to do that.

The threat is particularly significant for Free Software 
because proprietary software companies can sue new Free 
Software projects claiming infringement on their patents. 
Because many of these projects are started by volunteers, 
they have no revenue stream let alone a legal budget. Large 
commercial enterprises understand this and will be able to 

75 “Free Culture: How Big Media Uses Technology and the Law 
to Lock Down Culture and Control Creativity” by Lawrence 
Lessig. The Penguin Press 2004. ISBN 1594200068.
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start frivolous lawsuits in the knowledge that the mere threat 
of litigation will shut down a Free Software project that 
lacks a legal department.

This will have a chilling effect on innovation and may well 
cost the USA its lead in software development in the future.

For now, Free Software developers do have some allies. 
When the BBC began developing the Dirac video software 
they made a legal team part of their contribution to the 
project. Its lawyers are ensuring that no patents exist on the 
software techniques that Dirac uses, as well as patenting 
those new techniques that Dirac creates. It will then place the 
patents in the public domain so that they are available for 
others to use without fear of litigation. For GNU/Linux 
litigation, IBM, Novell and other companies are making 
their lawyers available to defend the operating system in the 
courts.

However, it is a sad day when the innovation that comes 
from small teams starting up depends on the patronage of 
large companies for legal defence.

That is where governments such as that of Poland come in. 
In December 2004 it successfully campaigned to remove the 
“Software Patent Directive” from the European Union's 
legislative agenda. In other words, citizens and companies of 
the European Union were spared the dangers of software 
patents and they have Poland to thank for this 
(www.thankpoland.info).

Of course, the Polish government did not make this decision 
by itself. It was advised by activists, citizens and companies 
that this would be the best course of action for Poland's 
interest. Nor was Poland's the only government that was of 
this opinion. In the European Union and around the world, 
governments are making the necessary investments. The 
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national governments of Venezula, Brazil, India, China, 
South Korea, Japan and others are all responding to their 
citizens' needs and supporting Free Software.

The end of the beginning or the 
beginning of the end?
All of these developments allow me to end on a happy note. 
I hope that you have enjoyed this book and that you found it 
useful. As I mentioned in the introduction: if reading this 
book can save enough money to employ one more nurse or 
one more teacher, or to allow one more start-up to succeed 
financially, then my job is done.

Above all, I hope that you learnt enough about Free Software 
to demand more freedom in how you use computer 
technology in your life. And I hope that you will share what 
you learnt with your family, friends and colleagues. We will 
all be winners when the principles and practice of Free 
Software spread through society.

Further resources 
● Mozilla Foundation – www.mozilla.org 

● Open Source Applications Foundation – 
www.osafoundation.org 

● Free Software Foundation – www.gnu.org 

● Veterans Health Information Systems and Technology 
Architecture (VistA) – www.worldvista.org 

● Lawrence Lessig – www.lessig.org 

● “Free Culture: How Big Media Uses Technology and the 
Law to Lock Down Culture and Control Creativity” by 
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Lawrence Lessig. The Penguin Press 2004. ISBN 
1594200068.

● Free Culture website – www.free-culture.cc 

● Thank Poland – www.thankpoland.info 

178

http://www.thankpoland.info/
http://www.free-culture.cc/


GNU Free Documentation 
License

Version 1.2, November 2002
Copyright (C) 2000,2001,2002 Free Software Foundation, 
Inc.
51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA
Everyone is permitted to copy and distribute verbatim 
copies of this license document, but changing it is not 
allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other 
functional and useful document "free" in the sense of freedom: to 
assure everyone the effective freedom to copy and redistribute it, 
with or without modifying it, either commercially or 
noncommercially. Secondarily, this License preserves for the author 
and publisher a way to get credit for their work, while not being 
considered responsible for modifications made by others.

This License is a kind of "copyleft", which means that derivative 
works of the document must themselves be free in the same sense. 
It complements the GNU General Public License, which is a 
copyleft license designed for free software.

We have designed this License in order to use it for manuals for 
free software, because free software needs free documentation: a 
free program should come with manuals providing the same 
freedoms that the software does. But this License is not limited to 
software manuals; it can be used for any textual work, regardless of 
subject matter or whether it is published as a printed book. We 
recommend this License principally for works whose purpose is 
instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, 
that contains a notice placed by the copyright holder saying it can 
be distributed under the terms of this License. Such a notice grants a 
world-wide, royalty-free license, unlimited in duration, to use that 
work under the conditions stated herein. The "Document", below, 
refers to any such manual or work. Any member of the public is a 
licensee, and is addressed as "you". You accept the license if you 
copy, modify or distribute the work in a way requiring permission 
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under copyright law.

A "Modified Version" of the Document means any work containing the 
Document or a portion of it, either copied verbatim, or with modifications 
and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of 
the Document that deals exclusively with the relationship of the publishers 
or authors of the Document to the Document's overall subject (or to 
related matters) and contains nothing that could fall directly within that 
overall subject. (Thus, if the Document is in part a textbook of 
mathematics, a Secondary Section may not explain any mathematics.) The 
relationship could be a matter of historical connection with the subject or 
with related matters, or of legal, commercial, philosophical, ethical or 
political position regarding them.

The "Invariant Sections" are certain Secondary Sections whose titles are 
designated, as being those of Invariant Sections, in the notice that says that 
the Document is released under this License. If a section does not fit the 
above definition of Secondary then it is not allowed to be designated as 
Invariant. The Document may contain zero Invariant Sections. If the 
Document does not identify any Invariant Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed, as 
Front-Cover Texts or Back-Cover Texts, in the notice that says that the 
Document is released under this License. A Front-Cover Text may be at 
most 5 words, and a Back-Cover Text may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, 
represented in a format whose specification is available to the general 
public, that is suitable for revising the document straightforwardly with 
generic text editors or (for images composed of pixels) generic paint 
programs or (for drawings) some widely available drawing editor, and that 
is suitable for input to text formatters or for automatic translation to a 
variety of formats suitable for input to text formatters. A copy made in an 
otherwise Transparent file format whose markup, or absence of markup, 
has been arranged to thwart or discourage subsequent modification by 
readers is not Transparent. An image format is not Transparent if used for 
any substantial amount of text. A copy that is not "Transparent" is called 
"Opaque".

Examples of suitable formats for Transparent copies include plain ASCII 
without markup, Texinfo input format, LaTeX input format, SGML or 
XML using a publicly available DTD, and standard-conforming simple 
HTML, PostScript or PDF designed for human modification. Examples of 
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transparent image formats include PNG, XCF and JPG. Opaque formats 
include proprietary formats that can be read and edited only by proprietary 
word processors, SGML or XML for which the DTD and/or processing 
tools are not generally available, and the machine-generated HTML, 
PostScript or PDF produced by some word processors for output purposes 
only.

The "Title Page" means, for a printed book, the title page itself, plus such 
following pages as are needed to hold, legibly, the material this License 
requires to appear in the title page. For works in formats which do not 
have any title page as such, "Title Page" means the text near the most 
prominent appearance of the work's title, preceding the beginning of the 
body of the text.

A section "Entitled XYZ" means a named subunit of the Document whose 
title either is precisely XYZ or contains XYZ in parentheses following text 
that translates XYZ in another language. (Here XYZ stands for a specific 
section name mentioned below, such as "Acknowledgements", 
"Dedications", "Endorsements", or "History".) To "Preserve the Title" of 
such a section when you modify the Document means that it remains a 
section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice 
which states that this License applies to the Document. These Warranty 
Disclaimers are considered to be included by reference in this License, but 
only as regards disclaiming warranties: any other implication that these 
Warranty Disclaimers may have is void and has no effect on the meaning 
of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either 
commercially or noncommercially, provided that this License, the 
copyright notices, and the license notice saying this License applies to the 
Document are reproduced in all copies, and that you add no other 
conditions whatsoever to those of this License. You may not use technical 
measures to obstruct or control the reading or further copying of the copies 
you make or distribute. However, you may accept compensation in 
exchange for copies. If you distribute a large enough number of copies 
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and 
you may publicly display copies.

3. COPYING IN QUANTITY
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If you publish printed copies (or copies in media that commonly have 
printed covers) of the Document, numbering more than 100, and the 
Document's license notice requires Cover Texts, you must enclose the 
copies in covers that carry, clearly and legibly, all these Cover Texts: 
Front-Cover Texts on the front cover, and Back-Cover Texts on the back 
cover. Both covers must also clearly and legibly identify you as the 
publisher of these copies. The front cover must present the full title with 
all words of the title equally prominent and visible. You may add other 
material on the covers in addition. Copying with changes limited to the 
covers, as long as they preserve the title of the Document and satisfy these 
conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you 
should put the first ones listed (as many as fit reasonably) on the actual 
cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering 
more than 100, you must either include a machine-readable Transparent 
copy along with each Opaque copy, or state in or with each Opaque copy a 
computer-network location from which the general network-using public 
has access to download using public-standard network protocols a 
complete Transparent copy of the Document, free of added material. If 
you use the latter option, you must take reasonably prudent steps, when 
you begin distribution of Opaque copies in quantity, to ensure that this 
Transparent copy will remain thus accessible at the stated location until at 
least one year after the last time you distribute an Opaque copy (directly or 
through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the 
Document well before redistributing any large number of copies, to give 
them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under 
the conditions of sections 2 and 3 above, provided that you release the 
Modified Version under precisely this License, with the Modified Version 
filling the role of the Document, thus licensing distribution and 
modification of the Modified Version to whoever possesses a copy of it. In 
addition, you must do these things in the Modified Version:

    * A. Use in the Title Page (and on the covers, if any) a title distinct from 
that of the Document, and from those of previous versions (which should, 
if there were any, be listed in the History section of the Document). You 
may use the same title as a previous version if the original publisher of 

182



GNU Free Documentation License

that version gives permission.

    * B. List on the Title Page, as authors, one or more persons or entities 
responsible for authorship of the modifications in the Modified Version, 
together with at least five of the principal authors of the Document (all of 
its principal authors, if it has fewer than five), unless they release you 
from this requirement.

    * C. State on the Title page the name of the publisher of the Modified 
Version, as the publisher.

    * D. Preserve all the copyright notices of the Document.

    * E. Add an appropriate copyright notice for your modifications 
adjacent to the other copyright notices.

    * F. Include, immediately after the copyright notices, a license notice 
giving the public permission to use the Modified Version under the terms 
of this License, in the form shown in the Addendum below.

    * G. Preserve in that license notice the full lists of Invariant Sections 
and required Cover Texts given in the Document's license notice.

    * H. Include an unaltered copy of this License.

    * I. Preserve the section Entitled "History", Preserve its Title, and add 
to it an item stating at least the title, year, new authors, and publisher of 
the Modified Version as given on the Title Page. If there is no section 
Entitled "History" in the Document, create one stating the title, year, 
authors, and publisher of the Document as given on its Title Page, then 
add an item describing the Modified Version as stated in the previous 
sentence.

    * J. Preserve the network location, if any, given in the Document for 
public access to a Transparent copy of the Document, and likewise the 
network locations given in the Document for previous versions it was 
based on. These may be placed in the "History" section. You may omit a 
network location for a work that was published at least four years before 
the Document itself, or if the original publisher of the version it refers to 
gives permission.

    * K. For any section Entitled "Acknowledgements" or "Dedications", 
Preserve the Title of the section, and preserve in the section all the 
substance and tone of each of the contributor acknowledgements and/or 
dedications given therein.

    * L. Preserve all the Invariant Sections of the Document, unaltered in 
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their text and in their titles. Section numbers or the equivalent are not 
considered part of the section titles.

    * M. Delete any section Entitled "Endorsements". Such a section may 
not be included in the Modified Version.

    * N. Do not retitle any existing section to be Entitled "Endorsements" or 
to conflict in title with any Invariant Section.

    * O. Preserve any Warranty Disclaimers. 

If the Modified Version includes new front-matter sections or appendices 
that qualify as Secondary Sections and contain no material copied from 
the Document, you may at your option designate some or all of these 
sections as invariant. To do this, add their titles to the list of Invariant 
Sections in the Modified Version's license notice. These titles must be 
distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains 
nothing but endorsements of your Modified Version by various parties--
for example, statements of peer review or that the text has been approved 
by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a 
passage of up to 25 words as a Back-Cover Text, to the end of the list of 
Cover Texts in the Modified Version. Only one passage of Front-Cover 
Text and one of Back-Cover Text may be added by (or through 
arrangements made by) any one entity. If the Document already includes a 
cover text for the same cover, previously added by you or by arrangement 
made by the same entity you are acting on behalf of, you may not add 
another; but you may replace the old one, on explicit permission from the 
previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License 
give permission to use their names for publicity for or to assert or imply 
endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this 
License, under the terms defined in section 4 above for modified versions, 
provided that you include in the combination all of the Invariant Sections 
of all of the original documents, unmodified, and list them all as Invariant 
Sections of your combined work in its license notice, and that you 
preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and 
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multiple identical Invariant Sections may be replaced with a single copy. 
If there are multiple Invariant Sections with the same name but different 
contents, make the title of each such section unique by adding at the end 
of it, in parentheses, the name of the original author or publisher of that 
section if known, or else a unique number. Make the same adjustment to 
the section titles in the list of Invariant Sections in the license notice of the 
combined work.

In the combination, you must combine any sections Entitled "History" in 
the various original documents, forming one section Entitled "History"; 
likewise combine any sections Entitled "Acknowledgements", and any 
sections Entitled "Dedications". You must delete all sections Entitled 
"Endorsements."

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other 
documents released under this License, and replace the individual copies 
of this License in the various documents with a single copy that is 
included in the collection, provided that you follow the rules of this 
License for verbatim copying of each of the documents in all other 
respects.

You may extract a single document from such a collection, and distribute 
it individually under this License, provided you insert a copy of this 
License into the extracted document, and follow this License in all other 
respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and 
independent documents or works, in or on a volume of a storage or 
distribution medium, is called an "aggregate" if the copyright resulting 
from the compilation is not used to limit the legal rights of the 
compilation's users beyond what the individual works permit. When the 
Document is included in an aggregate, this License does not apply to the 
other works in the aggregate which are not themselves derivative works of 
the Document.

If the Cover Text requirement of section 3 is applicable to these copies of 
the Document, then if the Document is less than one half of the entire 
aggregate, the Document's Cover Texts may be placed on covers that 
bracket the Document within the aggregate, or the electronic equivalent of 
covers if the Document is in electronic form. Otherwise they must appear 
on printed covers that bracket the whole aggregate.

185



Free Software for Busy People

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute 
translations of the Document under the terms of section 4. Replacing 
Invariant Sections with translations requires special permission from their 
copyright holders, but you may include translations of some or all 
Invariant Sections in addition to the original versions of these Invariant 
Sections. You may include a translation of this License, and all the license 
notices in the Document, and any Warranty Disclaimers, provided that you 
also include the original English version of this License and the original 
versions of those notices and disclaimers. In case of a disagreement 
between the translation and the original version of this License or a notice 
or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", 
"Dedications", or "History", the requirement (section 4) to Preserve its 
Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except 
as expressly provided for under this License. Any other attempt to copy, 
modify, sublicense or distribute the Document is void, and will 
automatically terminate your rights under this License. However, parties 
who have received copies, or rights, from you under this License will not 
have their licenses terminated so long as such parties remain in full 
compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the 
GNU Free Documentation License from time to time. Such new versions 
will be similar in spirit to the present version, but may differ in detail to 
address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If 
the Document specifies that a particular numbered version of this License 
"or any later version" applies to it, you have the option of following the 
terms and conditions either of that specified version or of any later version 
that has been published (not as a draft) by the Free Software Foundation. 
If the Document does not specify a version number of this License, you 
may choose any version ever published (not as a draft) by the Free 
Software Foundation.
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